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Changelog

7/1/2024 — Added missing Cisco Security for Chromebook Migration Google Identity Authorization step (pages 64-67).
Removed outdated “Deploy the G Suite Identity Service” instructions (removed from pages 86-89).

6/5/2024 — New Cisco Secure Client (Roaming Client Replacement) deployment steps added (starting on page 92) and
old Roaming Client deployment steps removed.

5/6/2024 — New Cisco Security for Chromebook Migration steps added (starting on page 62) and old Chromebook
Extension steps removed. Also added the Changelog section at beginning of document and updated Table of Contents.
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Umbrella Documentation

https://docs.umbrella.com/deployment-umbrella/docs/welcome-to-cisco-umbrella

Basic Level Filtering

The most basic implementation of the Cisco Umbrella filter will afford you the state’s default filtering level for
all your users. Simple and quick to implement, this level of filtering makes no distinction between your users
and is not Active Directory aware. All it requires is a change to the DNS forwarders on your local DNS
server(s).

OpenDNS Forwarders

Add the OpenDNS Forwarders to ALL of your DNS servers. The OpenDNS Forwarders are
208.67.222.222, 208.67.220.220, 208.67.220.222, and 208.67.222.220

1. Open DNS Manger or type DNSMGMT from run or CMD prompt

= Administrator: Command Prompt

fMicrosoft Windows [Uersion 6.3.96601
(c) 2013 Microsoft Corporation. All rights reserved.

\Users\fldministrator>dnsmgmt

2. Select your server name, right click the server name and click Properties

z DNS Manager
| File | Action View Help

e R RXEBaz BE §88

P [ Name

4| 5 2012DC1 Forward Lookup Zones
b | Forward Lookup Zones _ Reverse Lookup Zones
b || Reverse Lookup Zones | Trust Points
b ] Trust Points _| Conditional Forwarders
p = Conditional Forwarders @ﬂGlcbal Logs
b |2 Global Logs '“ Root Hints

& | Forwarders

3. Inyour DNS Server Properties, select the Forwarders tab
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https://docs.umbrella.com/deployment-umbrella/docs/welcome-to-cisco-umbrella

4. Uncheck the use root hints box and then click Edit

Debuglogging | Eventlogoing | Montoing | Securty
Intedaces Fowarders |  Advanced |  Root Hints

Forwarders are DNS servers that this server can use to resolve DNS
queries for records that this server cannot resolve.

IP Address Server FQDN
170.94.156.195 resolver] state arus
170.94.156.196 resolver? state ar.us

fUaemmumfwmmavawe
Not

e: Ucondionalforwa'dersaledd’nedforagvmdomahthey
used instead of serverdevel forwarders. To create or view
forwarders, navigate to the Conditional Forwarders node in the scope tree.

OK

5. Delete ALL existing DNS Forwarders, add 208.67.222.222, 208.67.220.220,
208.67.220.222, and 208.67.222.220 as your new forwarders
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Edit Forwarders *

IP addresses of forwarding servers:

IP Address Server FQDN Validated Delete
an IP Address or DNS Name =

'iﬂ' 208.67.222,.222 resolver 1.opendns.com OK L
i@' 208.67.220.220 resolver 2.opendns. com 0K

i@' 208.67.222,.220 resolver 3.opendns. com oK Down
'Z@' 203.67.220.222 resolver4.opendns.com 0K

Mumber of seconds before forward gueries time out: | 3

The server FQDM will not be available if the appropriate reverse lookup zones and entries are not

configured.
Cancel

6. Click OK > OK > Close your DNS Manager

7. Do this on every server that has DNS installed

Local IP Level Filtering

A second level of OpenDNS implementation requires installation of multiple virtual appliances on
virtual hosts within your network. Best Practices call for installing at least two appliances on two separate
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physical hosts for redundancy and fault protection. These appliances allow for more detailed reporting, and
custom filtering.

Virtual Appliance Requirements
Virtual Appliances (VAs) are needed for detailed reporting and identity information, Active Directory
Integration, and granular Policy Management. Listed below are the requirements needed for the VAs to work.

1. 2 VAs per Site — In order for automatic updates to occur without downtime and for redundancies
sake at the DNS level, you must have two VAs per site, each on separate Hypervisor servers.

2. VA Specs — Each VA requires the following resources:

a. 1 Virtual CPU

b. 1024 MB of RAM Recommended (minimum 512MB)

c. 7GB of disk space
NOTE: The above resources allow each VA to process millions of DNS requests per day. It is
estimated that 1 VA with the above mentioned amount of resources can serve over 100,000
endpoints.

3. Correct Date/Time — The incorrect date or time can cause update or sync issues with the VAs.
Ensure your Hypervisor host has the correct date and time. The VA syncs time independently and
is always set to UTC.

4. VMWare or Hyper-V — The VAs can run either on VMware or Hyper-V

a.  VMware requires ESX or ESXi 4.1 update 2 (or newer)
b. Hyper-V requires one of the following Windows Server Operating Systems:
i.  Windows Server 2012, SP1, or R2 (Standard or Datacenter), 2016, or 2019
with Hyper-V role
ii. Hyper-V Server 2012, 2012 R2, 2016, or 2019

VA Networking Requirements

Once VAs are deployed and ready to be utilized, endpoint clients must exclusively resolve DNS through the
VAs and not your local DNS forwarders. This is usually accomplished through the network’'s DHCP
configuration. The following firewall/ACL requirements ensure VAs can communicate with the Umbrella cloud
services and local DNS forwarders/servers.

Port and Source Destination Note

Protocol

53 TCP + Virtual Appliance | Local DNS servers Standard DNS traffic for internal domains.
UDP
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53 TCP + Virtual Appliance | Umbrella resolvers Standard and encrypted DNS queries to Umbrella resolvers.
UDP Default: Port 443 is used as failover if your firewall does not allow
e 208.67.220.220/32
443 TCP + DNSCrypt on port 53.
o 208.67.222.222/32 yptonp
DP Port i fail if DNSCrypt is not all t
U If you have configured the VA to ort 5353 is used as failover i SCrypt is not allowed on port 53
TCP t 443.
5353 ¥ use other Umbrella resolvers: and port 443
UDP
Alternate:
e 208.67.220.222/32
e 208.67.222.220/32
IPv6:
e 2620:119:35::35
o 2620:119:53::53
US-only:
e 208.67.221.76/32
o 208.67.223.76/32
US-only IPv6:
e 2620:119:17::76
o 2620:119:76::76
443 TCP Virtual Appliance : ?g;;ﬂ%nggszi%m HTTPS—Used for registration, health checks, and updates from
o 146.112.255.152/29) Umbrella.
¢ ocsp.d_lglcert.com ocsp.digicert.com and crl4.digicert.com use a CDN and are not
e crl4.digicert.com
e cisco.com assigned static IP addresses, thus are subject to change.
Currently, these domains resolve to the following IPs:
e 72.2191.29
e 117.18.237.29
e 03.184.220.29
e 205.234.175.175
80 TCP Virtual Appliance * ocsp.d_lglcert.com HTTP—Used for fetching the SSL revocation list to initiate the
e crl4.digicert.com
HTTPS connection.
443 TCP Virtual Appliance | disthost.umbrella.com Updates to the VA
Port and Source Destination Note
Protocol
22 Virtual Appliance | s.tunnels.ironport.com Required for the customer-initiated SSH support tunnel. For
255380443 more information, see On-Demand Tech Support SSH Tunnel for
or 4766 TCP Virtual Appliances.
123 UDP Virtual Appliance | NTP servers NTP—Protocol to synchronize time.

Default:
e ntp.ubuntu.com
o (91.189.94.4/32
e 91.189.89.199/32
e 91.189.91.157/32
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https://support.umbrella.com/hc/en-us/articles/115004154423-On-Demand-Support-Tunnel-for-the-VAs
https://support.umbrella.com/hc/en-us/articles/115004154423-On-Demand-Support-Tunnel-for-the-VAs

e 91.189.89.198/32)
If you have configured custom
NTP servers on the VA, use those

IPs instead.

443 TCP Chromebook Virtual Appliance(s) Required for Chromebook client trusted network feature.
client

443 TCP Umbrella AD Virtual Appliance(s) Used to send user/IP mapping (one-way) from the Active
Connector Directory (AD) connector to the VA.

Download Virtual Appliance:

1.
2.

3. At the top of the screen click “ D

Cisco Umbrella

Create a folder called openDns to download the necessary files to.
Navigate to Unmbrella.com and login. Then navigate to Deployments > Sites and Active

Directory (und

er Configuration).

v ..
e information =
Q

d Active Directory @

ownload Components”

Mobile Devices

Chromebook Users

Configuration
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OpenDNS-VM1 10111
OpenDNS-VM2 10112
DC1 10113
DC-2 10114
DC-2 10.1.14

Sites and Active Directory provides you with the means to integrate and deploy virtual appliances and Active Directory (AD). Active Directory (AD) integration supplements Umbrella virtual appliances (VAs)/and
roaming clients by providing AD user, group, or computer name information for each applicable DNS request

Q Search
Default Site Virtual Appliance © Imported: 2 years ago 283
Default Site Virtual Appliance @ Imported: 2 years ago 283
Default Site Domain Controller @ Run: 2 years ago

Default Site Domain Controlier @ Run: 2 years ago

Default Site AD Connector @ Installed: 2 years ago 1624

Page| 1 \/| ResultsPerPage] 10 \/| 1-50f5



https://docs.umbrella.com/deployment-umbrella/docs/trusted-network-detection
https://docs.umbrella.com/deployment-umbrella/docs/appx-a-communication-flow-and-troubleshooting
https://docs.umbrella.com/deployment-umbrella/docs/appx-a-communication-flow-and-troubleshooting

4. Depending on whether you’re using VMWare or Hyper-V, download the appropriate “VA for”

Download Components
Interested in learning more about our available downloads? Visit Umbrelia Docs

Active Directory Components

Windows Configuration script for Domain Controller DOWNLOAD

Windows Service (Active Directory Connector) DOWNLOAD

Virtual Appliance Components

Use as the defauit password for this VA.

VA for VMWare ESXi DOWNLOAD

VA for Hyper-V DOWNLOAD

CANCEL

5. If you plan to integrate Active Directory to your system, Download the Windows
Configuration script and Windows Service (see Configure Active Directory)

Each new school must download their own files from their Umbrella Portal as the files are tagged to
that school when downloaded.

Hyper-V Virtual Appliance Deployment
To deploy the VA in Hyper-V for Windows Server it is best to create a new VM and attach the
Hard Disk after the fact. For Server 2012 R2 it is mandatory.

1. Select your Hyper-V Server Name on the left and then select New > Virtual Machine in the
Actions menu along the right side of Hyper-V Manager
Click Next on the Before You Begin page if you get that
Name the VA with the format SCHOOL-VA followed by the number for the VA.
a. Ifthis is your first VA then the name should be YOURSCHOOL-VAL.
b. Check the Store the virtual machine in a different location
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c. Navigate to the location where VM’s are stored on this network

& New Vinus Machme Wizard > {
N ~ Specily Name and Location

=

Before You Begn Chooez & neme and location for thes vrtusl machne,

Specty Nase and Location The rame 15 doplaped 1 rpper & Martager, Ve recomerend that you use 8 name that helpe you sasty
Spenfy Genaraton dendify this virtual machine, such as the name of the guisst npersting system or morkond

Assgn Memory Name: SCHO0L-YAL

7 o
Corfgure Netwaring You can create a folder or use ¥ existing folder to store the wrtual machine, If you don't celect a

Cornect Yriual Hard Disk folder, T virkial machine S stored In the default flder configured for this server

Instaladon Opbons ] Store $he vrtusl machine 1 diffisent ncation
Susmary tocatoni (T Browse.,

§. TF you plan o take checkponns of ths vetual machice, selact a location that has erough free
space. Creckponts ndude virtun machioe data and may reguire a large amcunt of space

< Pravius Fih Canenl

4. Click Next
Make sure Generation 1 is selected. The VA’s are built using this format. Click Next
Assign 1024MB of RAM to the VM. As mentioned in the VA Requirements section, 512
MB is estimated to serve 100,000 endpoints a day. Click Next
Select your Network Adapter and click Next
Select the option at the bottom: Attach a virtual hard disk later and click Next
Click Finish

Now we need to copy the .VHD files you downloaded in the Prerequisite section to the newly
created VM location and configure the VM Settings.

1. Find the file you downloaded all of your Prerequisite files to. Find a .zip file named
OpenDNSVirtualMachine-20151203 and extract it.
Open the newly extracted file and Copy the Virtual Hard Disks folder.
Navigate to the folder containing the VM on the Hyper-V Server (The location assigned in
step 3 of the previous section.)

4. Paste the Virtual Hard Disks folder into the folder named after the VM you created.
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5. Go into the Virtual Hard Disks folder and rename the two .VVHD files to dynamic-va-1
and forwarderva-1 (change the 1 to a 2 if this is your second VA)
| ¥ || = | SCHOOL-VA1 — O -
Home Share View 0
: A | F S (B8 f v
* = D e « Moveto~ X Delete ~ 4_3 M o B setect
e il~ ] "0 Select none
Pinto Quick Copy Paste - v = New Properties ;
access m - Gopyto II SEuRme folder - g Invert selection
Clipboard Organize New Open Select
<« v 1 <« HV » SCHOOL-VA1 v 0 Search SCHOOL-VA1 ye
(=] Pictures * |2 Name - Date modified Type
HV Virtual Hard Disks 12/7/2016 2:33 PM File folder
Pictures Virtual Machines 12/7/2016 1:52PM  File folder
Virtual Hard Disk
Virtual Hard Disk
7@ OneDrive
[ This PC
[ Desktop
[£] Documents
LN b IS <
2items  1itemselected  State: @R Shared
6. Go back to your Hyper-V Manager
7. Right Click the VM that you created and go to Settings
8. Select IDE Controller 0
9. Make sure Hard Drive is selected on the right hand side and click Add
i Settings for SCHOOL-VAT on DIS-SHELBYSERV » - <
SCHOOL-VA v/ 4 0 G
L ff“";";‘:w Wil 1€ Controler
_wy as o!mmmtmmmmmummmd«m. :
. n P’W ;D'/DDMG
w urie
= I IDE Controler 1 = # Hard Drive

&4 sCsi Controler

You can configure a hard drive to use 8 virtual hard dsk or a physical hard disk after
# § Network Adapter

you attach the drive o the controler,
5 com1
5 com2
fed Disketts Orive

2 Management

&3 Smart Paging Fe Locaton

D Automatic Start Acton

[® Automatie Stop Actcn

Co] [ conad

You can change how this virtual hard disk is attached to the virtual machine. If an
operating system is instaled on this disk, dhanging the attachment might prevent the
virtual

machine from startng.
Controfler: Location:
IDE Controler 0 v [0 guse) v
Meda

You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
by editing the associated fle. Specfy the ful path to the fie,

@® Virtual hard disk:
N ]
L

Browse...

L)

& 1F the physical hard dsk you want to use is not ksted, make sure that the

disk is offiine. Use Disk Management on the physical computer to manage
physical hard disks,

To remove the virtual hard disk, click Remove. This dsconnects the dsk but does not
delete the associated fie,

Remove

10. Click Browse and navigate to the location of the hard drives you just copied above.

11. Select forwarder-va-1 (or -2) and click Open
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12. Repeat steps 8-10 for the dynamic-va-1

i Settings for SCHOOL-VA1 on DIS-SHELBYSERV o - X
SCHOOL-VA1 v 40 |Q
2 Hardware X e ieanme
¥ Add Hardware
& Bl0s You can change how this virtual hard disk is attached to the virtual machine. If an
SN L e operating system is installed on this disk, changing the attachment might prevent the
bt virtual machine from starting.
o M""‘,",g Controller: Location:
mP;;essor 1DE Controler 0 v | 11 (inuse) 03
1 Virtual processor Media
= B8 IDE Controller 0 You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
# @ Hard Drive by editing the associated fle. Specify the full path to the fle.
forwarder-va-1.vhd @ Virtual hard disk:
# Ca Hard Drive
PGB |C:¥viSCHOOLVA1\irtual Hard Disks\dynamic-va-1.vhd |
I =i v | [ | [ e | [ ]
B 5 il pe—
@ § Network Adapter
LAN Internal 10 @ 1f the physical hard disk you want to use is not listed, make sure that the
'? COoM 1 disk is offine. Use Disk Management on the physical computer to manage
FtS physical hard disks.
Y com2
None To remove the virtual hard disk, dick Remove. This disconnects the disk but does not
Huée}m - delete the associated fie.
None Remove
A Management
e
13. Click Apply and OK
NOTE: forwarder-va-1 must be the first drive (location 0)!!
VMWare Virtual Appliance Deployment
@ Twetey T Toeree
!—"
“‘ Dy S o v A
1. Log into your VMware vSphere client and . 3 |
. , S B St w e S T smtage S w S v
select the 'File" tab.

W s ac S ot P Wt e e e

Do
2. Click Deploy OVF Template, choosing the

o:_;;-Ia-m. .
.OVA template downloaded from the Umbrella "':'__ =
dashboard.

& Denry

# Dienate

b Bt P R -

- L

[Le— '_~"

. M
- Pt -
o
R e
-~ Cymnliés mES

3. Follow the deployment wizard prompts, but be sure to follow these key steps:
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-For the source, browse to the .ova file you downloaded during the Prerequisite
section. -Specify a unique name and location of your Virtual Appliance

Mame and Location
| Speofy a name and iocatian for the deployed template

Sourcs Name:
QVE Terpiate Detaly
pocre humem
Storsoe The name can contan up 1o 80 characters and it sust be unque within the nventory folder,
Drsk Format
oyt Inventory Locaton: =

| oarormt |
‘ In which format do you want 1o store She wWiual deks?

Sorce e =
] ONF Temglate Detaly

fharee g Lacabon Avalable mpace (G8): [_znu
, Disk Format

P twork Magewng

Ready 16 Complete T Lary 2 " I

5. Next, select or map a network:

OVF Template Detais Map the networks used in this OVF template to networks in your inventory

Thin Provision.

tHost / Chusier

'Resource Pool

Storage

Digk Format

Network Mapping

6. Click Finish.

The systems will begin deploying the Virtual Appliance and subsequent prompts will update you regarding
the status.
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Configure the Virtual Appliances
It’s time to configure the VAs. You will need the following information.

. Right Click the VM and click Connect
2. At the top of the new window select the Green Power Button
3. Letthe VM load until you see the following image (If you have DHCP it will
automatically obtain an IP, my example does not)

SYstem

Forwarder Status
Mame :

MAC: 00:15:5d:5

Connectivity

This DNE Serwver: DNE ok .

Lo - s | igured
s incompled

0 domains

version:  2.4.4

4. Press Ctrl+B to enter Config Mode

after you sign in.
g he Umbrell

(M

5. You will find your Org ID in the URL of your Umbrella Dashboard. In the example below the

OrgIDis 2385312

< & & https://dashboard.umbrella.com
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6. Enter the default password, in this example | will use Umbrella2385312 (you won’t see any text when typing
the passwords)

7. Once logged in, you will be prompted to change the password. First you will enter the default password
again. Umbrella2385312

#*

You have 1 1 in with the default jord.
er the default password at the prompt of ©(current) UMIY

the following criteria:
.
LOne upper : letter and an integer.

""" in ord only if your keuboard layout is "EnglishiUnited

rd immediately (root enfor

10. Finally you will be at the config mode prompt.

nt an M 4. Use the 'config' command for any configuration changes.
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12. After you press enter you will see it sets the name.

chool-YAl

13. To set the IP address type: config va interface <IP address> <Subnet> <Gateway> then press enter

% config va interface 192.168.88.11 255.255.255.0 192.1/58.858.2_

14. After you press enter you will see it sets the IP info.

15. To set the local DNS servers (most commonly your DC’s) type config localdns add <dns1> then press enter,
type config localdns add <dns2> then press enter. Each DNS server has to be added with the command
individually.

fig localdns add 192,158,283, 10

Localdns Serve

17. That completes the config process, type exit to exit the config mode
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18. You will now see that your VA is fully configured.

Forwarder Status
Wame: School-Wail

MAC: 00

19 domains

Version: 2.4.4

NOTE: If Support Tunnel: SSH is red and says failed, it may take a little longer for it to make a
connection. It won’t hurt anything

if it doesn’t at all. This tunnel is for OpenDNS techs to be able to remote into your VA to assist you
if you request it.

It is also normal to see the “AD Connector: Unknown” message, as the optional Active Directory
integration has not been configured as of yet.

Repeat Steps for the second VA

Repeat the above steps to configure a second VA. A second VA is required for continuous operation, high

availability, and automatic upgrades. Do not clone the first VA. Umbrella will not recognize a cloned VA.

Warning

Umbrella VAs cannot be cloned. Ensure that your second VA is set up manually. Umbrella will not recognize a
cloned VA.
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Local IP and Active Directory Filtering

Finally, OpenDNS can be fully linked to your Active Directory structure. This option provides you with the

most detail in reporting and identity.

Prerequisites

e Windows Server 2012, 2012 R2, 2016 or 2019 with the latest service packs and 100MB free hard disk
drive space. Service packs prior to SP2 are not supported.

e _.NET Framework 4.5, or 4.7.

.NET Framework 3.5 should not be running on the same system. If .NET Framework 3.5 is required,
confirm that all Windows patches on this server are applied.
e If alocal anti-virus application is running, allow list the OpenDNSAuditClient.exe and

OpenDNSAuditService.exe processes.

Create AD User:

If you are going to use the AD connector then a user needs to be created and assigned to specific groups for the

connector to access AD.

1. Open Active Directory Users and Computers and Navigate to YourDomain.local > Users

2. Right Click > New > User
3. Make the User logon name: OpenDNS_Connector
4

When creating the password, do not use a backslash or quotation marks.

3 Cmma s achod locsl/ Uses 3) Ceaten  school Jocal/Users
“d r E
Fest nave Oper: Veus P ageword srsnannan ‘ E
Last nama ONS Corbrm passeord (eessssves | t
< — L
4 name o OIS T Dear st Crange Datswerd of e 0gon ?
]
e 092 Name User corvdl crunge pasevesd F
|OpenON §_Convecsor Sacrool s - o Passmtrd rever mpeea i
» i
Lser lngan name e Windoes 2000) Accourt s Ssatied
SCHOOL OpenDNS Corvector
foest Concel « Back Neat » (arce f
OpenDNS Connector Properties |7 NG
Once the user 1s created, add the user to the following e i o g e
: icle -~ Py 43 Genenl | Acows | Accout | Fafle | Teepteres | Ogonizston
groups by right clicking the user > Properties > e R By R e
Member Of tab > Add g
a. Event Log Readers s Acoren Comctary [ioman Sacvons Fobae

b. Distributed COM Users
c. Enterprise Read-only Domain Controllers
Click Apply and OK

NOTE: Make the user exactly like the picture.
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DCOM Permissions
Even though we have added the new user to the correct member groups in AD, we need to manually add the
OpenDNS_Connector user permissions. This may seem redundant but sometimes, even though the user is part
of the groups, they don’t always get the permissions needed. Let’s start with the DCOM permissions.

1. Open a CMD Prompt and type DCOMCNFG

G Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.96001
(c> 2013 Microsoft Corporation. All rights reserved.

:\Users\Administrator>DCOMCNFG_

1. When the new window opens, expand Component Services and click on Computers.
Right Click on My Computer and select Properties

)

#. File Action View Window Help
ad I XKE G

(L1 Console Root
v #. Component Services

| Computers
{35! Event Viewer (Local)
Services (Local)

2. In the new properties windows, click the COM Security tab

My Comput‘erties IL_

Defaul Protocols | COMSecuty |  MSDTC |
General ‘ Options | Default Properties |

Name: 2012DC1

e

Description:
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3. Under the Launch and Activation Permissions section, click on Edit Limits...

My Computer Properties ? X

General Options Default Properties
Defauit Protocols COM Security MSDTC

Access Pemissions

You may edit who is allowed default access to applications. You may
also set limits on applications that detemine their own pemissions.

Caution: Modfying access permissions can affect the ability
! of applications to start, connect, function and/or un
~ securely.

| Edtimts. | | EdtDefau..

Launch and Activation Pemmissions

You may edit who is allowed by defautt to launch applications or
activate objects. You may also set limits-on applications that
detemine their own permissions.

Caution: Modifying d activation pemmissions can
1 affect the abilty of ap, ons to start, connect, function
" and/or run securely

[ Edtimts. | | EctDefaut. |

4. Select Add.. then type in OpenDNS_Connector in the box and click Check Names and

OK

Select this object type:

IUsers. Groups. or Builtin security principals | I Object Types... |
From this location:
[districtocal | [ Locations... |

Enter the object names to select (examples):

OpenDNS_Connector] Check Names

5. Select the OpenDNS_Connector user and put a check mark in all four boxes below.

Security Limits
Group or user names:
2, Administrators {DISTRICT\Administrators) Al
% Performance Log Users (DISTRICT \Performance Log User
ﬂé, Distributed COM Users (DISTRICT\Distributed COM Ui
2 Open DNS (OpenDNS_Connector@district local)
< i
Pemissions for.%eﬂ DNS Allow Deny
Local Launch ) [}
Remote Launch %] O
Local Activation IZI [
Remote Activation vl O
ok || Cancel |-

Click OK > OK > Close the Component Services window.



7. Restart the machine.
WMI Permissions
1. Open a CMD Prompt and type WMIMGMT and press Enter
o Administrator; Command Prompt
icrosoft Windows [Uersion 6.3.966801
i(c)> 20813 Microsoft Corporation. All r»rights reserved.
\Users\Administrator>WMIMGHMT _
2. When the WmiMgmt window opens, right click on WMI Control (Local) and select
Properties
=) WmiMgmt - [Console Root\WMI Control (Local)]
ﬁ File Action View Favorites Window Help
& 7=
’T_] Conso!eT(cot )
i WMI Control (Local) |““] Windows Management Instrumentation (WMI)
Configures and controls the Windows Management Instrumentation
(WMI) service.
3. Select the Security tab, expand Root, highlight CIMV?2, then click the Security button at the
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bottom on the window
WMI Control (Local) Properties |2 [

General 5 Backup./Restore | Securty [ Advanced \

Namespace navigation allows you to set namespace specific security.

=i-| 4 Root ~
11 AccessLogsin

& Ci

41 DEFAULT

41 directory

41 Hardware

41 Interop

.41 Inventorylogging

41 Microsoft

1 MicrosoftActive Directory.
41 MicrosoftDfs

41 MicroscftDNS

41 msdtc

nap
+ i1 Policy
L -5 RSOP L
’ Security il

Processor : Intel(R) Xeon{R) CPU ES620 @ 2.40GH:z OK l | Cancel 1
Operating System : Microsoft Windows Server 2012 R2 Standard

i

wMi Conglyocal) Properties | 2

General | Backup/Restore [ Security l Advanced |

£ This dialog allows you to get general information about the
'3}& computer.

<

S i o i 5 i 5 o = g g = g o gt g = g g o o g

Successfully Connected to: <ocal computer>




4. Verify that the 7 ‘Security for ROOT\CIMV2: -
OpenDNS_Connector user is ' '

o ; el
listed with the following & :
. . roup or user names:
permissions. 52, Autherticated Users
Enable Account: Allow LA SHC-

Remote Enable: Allow
Read Security: Allow

iti i i [ Add... l I Remove l
If it is not, then add it with these
permissions. Pemissions for Open DNS ;\i‘ow ID_,eﬁy ’
Provider Write | W
Enable Account ]
Remote Enable [v] | =
5. Click OK > OK > Close the Read Securty % Q, g
WmiMgmt window. Edt Securty |

For special pemissions or advanced settings,
click Advanced.

ok |[ cancd || A

Active Directory Integration
Confiqure DNS

It’s time to prepare your network for Active Directory Integration. You will want to create PTR and
A records for your VAs on your DNS servers.

Open your Server Manager on your Primary DNS server

Click Tools > DNS

Expand your server name > Forward Lookup Zones

Right Click your domain and select New Host (A or AAAA)

In the first box put the name of the VA that you used when you configured it.
In the IP Address: box put the IP used during the configuration.

Make sure Create associated pointer (PTR) record is checked
Click OK.

o N o o~ wDh e
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9. Repeat steps 4-8 to add your second VA.

File Action View Help

o9 2F XEe=z HBHE & 8
. DNS Name “ Type Data
4 35 WINSERV-2012R2 £ (same as parent folder) Start of Authority (SOA) [217], winserv-20
4 Forward Lookup Zones T (same as parent folder) Name Server (NS) winserv-2012r2.s
b (=) _msdes.schoollocal || & (same as parent folder) Host (A) 10.10.0.2
p =) school.local msdcs
p Reverse Lookup Zones e
B || TrustPoints _tcp
p | Conditional Forwarders _udp
> |£3] Global Logs x
b i@ GlobalLog | DomainDnsZones
ForestDnsZones
New Host “ Host (4) 10.10.0.4
Host (A) 10.10.0.5
Name (uses parent domain name if blank): Host (A) 10.10.3.0
| SCHOOL-VA-1 | Host (A) 10.10.0.2
Host (A) 10.10.0.3

Fully qualified domain name (FQDN):
’SCHOOLNA-LsdmoLbcd. ‘

IP address:
|1o.1o.0.10| ‘

[] Create associated pointer (PTR) record

[ ] Allow any authenticated user to update DNS records with the
same owner name

Add Host H Cancel

Do an nslookup in Command Prompt using the IP of the VA followed by another using the NAME
of the VA to test that the records are created correctly and functioning.

cih. Administrator: Command Prompt |L|i_—

icrosoft Windows [Uersion 6.3.96001]
(c)> 2013 Microsoft Corporation. All rights reserved.

\Users\Administrator>nslookup 10.160.6.10
erver: odns—va—-1l.school.local
ddress: 10.10.8.4

ame = school-va—1.school.local
ddress: 16.10.8.10

:\Users\Administrator>nslookup school-va-1
erver: odns—-va—-1.school.local
ddress: 10.168.6.4

on—authoritative answer:
ame : school-va—1.school.local
ddress: 10.160.6.10

:\Users\Administrator>
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Configure Active Directory

Now we need to configure Active Directory to prepare it for the Connector. In order to do so we
need to run a script that you downloaded during the Prerequisite portion of this guide. Make sure
your openDns folder that you downloaded all of your prerequisite files to, is in the Downloads
folder or a folder easy to navigate to. For this guide we will use the Downloads folder.

1. Open an ADMIN CMD Prompt on your server and navigate to your openDns folder
inside your Downloads folder. (CMD: cd Downloads/openDns)

2. Type: cscript OpenDNS-WindowsCon and press the Tab button to auto fill the rest of the
name or manually complete the name and press Enter.

Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.96601
(c)> 2013 Microsoft Corporation. All rights reserved.

:\Users\Administrator>cd Downloads/openDns

:\Users\Admninistrator\Downloads\openDns>cscript OpenDNS—UWindowsConf igurationScyr
ipt—201308627.usf

3. The script will display your current configuration, then offer to auto-configure the Domain
Controller.
Press Y and Enter.

HE~-WindawsCont igurat tonScripl

giFat don, N1l pights rezersed.

Contraller Ty ar nd7 g
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4. Copy the script to each one of your DCs and repeat steps 1-3 to fully prepare your AD
environment for the connector.
5. Verify your AD Server shows up in the OpenDns Dashboard.

Connect Active Directory

The next step is to install the Active Directory Connector now that the VAs have been installed and
the Script has been ran on ALL of your DCs. You will need the password to the
OpenDNS_Connector user that you configured at the beginning of this guide. You only need one
connector per site.

1. Open the openDns folder that houses all of your Prerequisite files. Find the .zip file
OpenDNS-WindowsService-20160128.zip and extract it.
Once extracted, open the folder and run the setup.msi
When prompted, enter the password you used to configure the user OpenDNS_Connector
in the Prerequisite section of this book.
Follow the setup wizard prompts and click Close when finished.
Verify that the server name you installed the connector on shows up in the OpenDns
Dashboard (Settings > Sites and Active Directory) and that in the Type Column it shows
AD Connector next to it.

NOTE: You can verify that the integration is complete by verifying that the jellies in the status
column of Sites and Active Directory in the Dashboard are showing green in all boxes, especially
the AD Connector box and the AD Server Box. It may take a few minutes for them to turn green
and the import to show results. Once they are green you can verify further by going to Policies >
Policy List and creating a new Policy and confirming that your groups are present.

Setup DHCP

Now that you have your VAs installed and configured, your AD is integrated into the Umbrella
Dashboard, and your Policies List is setup the last thing you need to do is configure your DHCP to
handout your new VAs as the DNS servers for your network.

1.  Onyour DHCP Server open Server Manager > Tools > DHCP
2. Expand your Server Name > IPv4

g DHCP

A

File Action View Help

3
b

HCP ' Contents of DHCP Status
winserv-2012r2.school.local 3 winserv-2012r2.school.local

9
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3. Left Click on Server Options in order to get the right click menu to be available. 4. Right Click
Server Options and select Configure Options

File Action View Help

e« z2m ¢ HE &

@ DHcP
4 ﬂ winserv-2012r2.school.local @ Server Options
4 G IPva
3 S 10.10.0.0] 10.10
P :j s::ie, [(\M;nnr 1 Server options are additional configuration paran

or example, some commonly used optio

& Pol | °°"fi99'e Options... rvers, and DNS servers.
b # Filt View i |
b i 1Pv6 ptions act as defaults for all scopes. You

Refresh on in Scope Options.

Help ne server options, on the Action menu, cl

5. Put a check in the box next to 006 DNS Servers
NOTE: If there is already a Check Box here just delete and servers already listed.
6. Either put the name of the VA in the Server Name: box and click resolve or enter the IP
Address in the box below it and click Add.
7. Repeat Step 6 for your second VA.

For more information about server options, see o

General | Advanced

Available Options | Description |
[J 004 Time Server Amay of time_|
[ 005 Name Servers Amay of nan
006 DNS Servers Amay of DN,
[ 007 Log Servers Amay of MIT v |
<| > |

Resolve

10.10.0.10 Remove
Up

Down

8. Click Apply and Ok
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NOTE: Depending on your lease time, after updating the DNS Servers in the DHCP options, wait
for DHCP leases on the endpoints to expire and see the new changes. In most cases, DHCP lease
durations are 7 days or less, but sometimes may be set to higher values.

Final Configuration

Confiqure Internal Network

Internal Networks allows to you manage your Umbrella policy for subnets of computers based on
the internal IP addresses of your network.

After an Umbrella Virtual Appliance (VA) has been deployed, an Internal Networks identity can be
configured. To set this up, drop one of our lightweight VAs into your network, direct your DNS
traffic through it, and start mapping your network based on specific internal IP addresses and/or
subnets.

The purpose of the Internal Networks identity is to define a subnet that's non-routable (or RFC1918
compliant) as an identity you can apply policy to. To create an Internal Networks identity, define a
subnet that's non-routable (or RFC 1918 compliant) as an identity you can apply policy to. For
example, if your Internal Network is defined as 192.168.0/24, any computer, tablet or device with
an IP on that subnet would receive the filtering policy defined for it whenever it made a request to
access the Internet.

From there you can begin to build multiples sites if you have more than one physical location or if
you have more than one Internal Network to configure.

The Umbrella VA will have your DNS traffic pointed to it for this configuration and anything
identified as coming from the networks you've defined will have the policies applied.
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1. Navigate to Deployments > Configuration > Internal Networks and click Add.

Cisco Umbrella als, DedoymENS  Comgurston i~
i @)
Nl
© Ui Internal Networks e
| search Intemal Networks... | a |
1
_ AT .
Roaming Computers Camera Network 9 Defauk Site 10.112.108.0/24 | Defaul Policy
. High School Campus Q@ Defautt Site 10.112.160.0/20 | Default District Pali_
n HS-Oculus-02 9 Default Site 10.112.165 54 Technology Policy
Chromebook Users
HSOculus03 9 Default Site 10.112.165.108 | Defaul Policy
Configuration
JR-High-OculusSystem 9 Default Site 10.112.161.191 | Default Policy
Internal Domains
Judsonia Elem Campus 9 Default Site 10.112.144.0/22 | Default District Pali.__
Site Active Directory
Kensett Elem Campus Q Default Site 10.112.116.0/22 | Default District Pali.__
Internal Networks
Oculus Q Default Site 10.112.205.12... | Technoloav Policv

2. You'll be asked to name your network and provide a valid subnet. In this case, we've picked
a /24 subnet, so the final octet of the IP will be .0

Deployments / Configuration .’0‘-.
e ] '.\_7 ,_/'I
asco  [nternal Networks P
‘ Search Internal Networks... ‘ a ‘
Network Name IP Address
| Elem-Private] x | | 10.44550 23(5121Ps) [v]
Site
| Default Site = |

3. Click Save.

Note: If you are unable to save your changes, it may be because the Cisco Umbrella Internal
Networks setup does not allow an invalid range to be configured. The basic principle is that the
final octet of your IP range should match the mask for that range. More information about subnet
masks, as well as tools, are easily available from many third-party websites.

You can assign an individual Internal Network policy to a single IP address or to an entire DHCP
scope that's already been configured for your network.
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Domain Management

1. Inthe Umbrella dashboard, navigate to Deployments > Configuration > Domain Management.

alial, Deployments [/ Configuration lé'
© s Internal Domains ¢ —_—

Add

Want to route certain domains to your local resolver? You've come to the right place. Click " Add" above to get
started.

Note: When you add a domain, all of its subdomains will inherit the setting. For example, if example.com is on the

internal domains list, www_example_com will also be treated as an internal domair

Domain Description

This internal domain applies to:

All Appliances and Devic[]

Any DNS queries received by the VAs which match a domain on the Domain Management list, or
subdomain thereof, will be forwarded to the local DNS server as described in Configuring your VAs.

The following domains/zones are pre-populated and do not need to be added:
e RFC1918—Non-publicly routable address spaces used only for reverse DNS on internal networks.
All local IP address space for reverse lookups (PTR records) is covered with this entry. Adding in-
addr.arpa reverse lookup zones is not needed.
e .local—Any domain name with a TLD of .local.

You have a choice of what type of identities are set to respect these internal domains:
e All Appliances and Devices
e Roaming Devices Only
e Virtual Appliances Only

If you do not plan on using Umbrella roaming clients**, you may leave this option at the default setting (All
Appliances and Devices). If you plan on using Umbrella roaming clients, we recommend reading the
following document and document subsection for more information:

*Appx B. Virtual Appliances

*Appx D. Internal Domains

Which domains should be added?

Any domain name which has a forward lookup zone on your local DNS servers must be added. If you
already know which domains to add, click here to skip this section.
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On Windows Server, this information is located in the DNS Manager tool.
1. Open the DNS Manager (Start > Run > and type "dnsmgmt.msc").
2. Expand the Server name and Forward Lookup Zones sections. Any domains listed here are treated
as local by your local DNS forwarders and must be added to the Internal Domains section of the
Umbrella dashboard. This is a critical part of the setup process.

Configure Policies

Before we convert your network to OpenDNS you might want to setup your filtering Policies.
OpenDNS Policies are a top down process, meaning your endpoints will start from the top of the
list and work their way through to the bottom. If they do not get blocked by any policy that is linked
to them, then they will be allowed access.

The bottom Policy will always be Default Policy and this is the state level policy that blocks
Pornography only. It uses the “Centralized Default Settings” Category Setting which is managed
by the state and can only be edited by the state.

This guide will walk you through setting up your own District Default Policy to site above the
State Default Policy so that you can manage your bottom level filter. It is recommended that you
make this a very restrictive policy to be your safety net at the bottom of your policy list.

Before we can create the Policy itself, we need to create the Destination Lists, Category Settings,
Application Settings, and Security Settings.

Destination Lists

For each policy you will need 2 Destination Lists, one will be an Allow list and the other will be a
Block list. These two will be your granular control on each policy allowing you to Block or Allow
websites on a URL basis. If your End Users find a website that is being blocked by a Category in
your Policy and you do not want to unblock the whole Category to allow access to this particular
website, you would put the website in the Allow Destination list.

1. Navigate to Policies > Destination Lists
2. You will see two Destination Lists already exist. Global Allow List and Global Block List
a The Global Allow and Global Block will always be attached to every Filter
Policy and cannot be removed. For this reason, you should be very careful what
you add to these two destination lists.
b If you already have a Whitelist or a Blacklist from another filter, you can upload
using a .CSV file with each domain on a new line, and select Bulk Upload
Domains.

3. Tocreate a new Destination List, click the small blue plus sign at the top of the page.
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4. Type a name and choose whether this is an Allow or a Block list and click Save.
5. Create both a Default Allow and a Default Block Destination List.

< Back To Multi-org Console

Pelicies / Policy C o

ol Destination Lists e
‘aisee’ Cisco Umbrella

Destination Lists enable you to customize your policy to block or allow any domains then apply those lists to your policies. Adding wildcards to your bloc
APSCN-Robaert Thompsan Test domain.com will also allow or block subdomain.domain.com. You can also allow IP addresses and CIDR ranges for Roaming Computers with the Reamin 9

Q s

New Destination List

List Name

Student Block

Destinations in this list should be:

@ Biocked Allowed

arch CLEAR

nba.com DOMAIN

Category Settings

. Inthe OpenDns Dashboard, Navigate to Policies > Category Settings
2. Here you will be able to VIEW the “Centralized Default Settings” Category List but not
edit it. Another Category List should already exist called Default Settings. This one you
can edit but not delete so let’s click on it.

a. To add your own Category Lists in the future, click the blue plus sign at the top of
the page.

3. Navigate through the list putting checks in everything that you want blocked in your overall
filter.

< Back Te Multi-org Console

sco Umbrella Add New Content Setting
APSCN-Robert Thompson Test Setting Name
Faculty Black
Copy From Existing
None
CATEGORIES TO BLOCK SELECT ALL
[} ]
Academic Fraud Radio
=] =
Adult Themes Religios
= =
Adware Research / Ref
@ o =
Alcohol Humor Search Engin
[} - ]
Anime / Manga | Webcomic Instant Messaging Sexuality
"
Auctions Internet Watch Foundation Social Networking

a. Always check Pornography when creating EVERY Category Setting. This is
because once a user authenticates to a Policy in OpenDNS, they are then governed
by that policy only. I.E. If Pornography is blocked in every Category Setting for
every policy OTHER than your Students, then when students authenticate and pull
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Catcgories

0oOooDooOODODOODDODODODOOOODOOOOODOODODOOOOODGOO

the Student Policy, they would be allowed to access porn no matter what policy is
above or below them.

b. This filter will be the Default Filter that devices on your network will get if they do
not fit into any Identity Groups in any other filter.
When you have selected all of the Categories that you want blocked by default on
your network, click Save. Below is the list of all Content Categories.

& CONTENT CATEGORIES

SELECT ALL

Audult

Avtvertisements

Allc okl

Animals and Pets

Arts

Astrology

Awusctions

Business and Industry
Cannabis

Chat and Instant Massaging
Chaating and Plagiarism
Child Abuse Contant
Clowd and Data Genters
Computer Security

Coomputers and Interneat

Con i c nces and Trade Shows
Cryplocurrancy
Drating

Digital Postcards

Dinimg and Drinking

DY Projects

DvoH and DoT

Dymamic and Residential
Education
Entertainment

Extreme

Fashion

File Transfer Sarvices
Filter Awcidance

Finance

Freeware and Sharewarsa
Giambling

Games

Giowermament and Laww
Heacking

4 CONTENT CATEGORIES (LEGACY)

Categories

SELECT ALL

Academic Fraud
Adult Themes
Advrare

Ani M

W i

Automotive

Blogs

Business Services
Chat

Classifieds

Drugs

Ecommerce / Shopping
Educational Institutions
File Storage

Financial Institutions
Forums f Message boards

German Youth Protection

oo000ODODDOOOODODOODO

Government
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Hate Speech

Healkth and Medicine
Hummnor

Humnting

INlegal Activities
INegal Downloads
INegal Drugs

Infrastrecture and Content Delivery Metwor._

Intermet of Things
Intermet Telaphony
Job Search

Lin e and Swir i
Lotteries

Military

Maobile Phones
Museums

Mature and Consernvation

MNews

Morn- gower I Ohrgand '
MNon-sexwal Mudity

Mot Acticnakle

Onilinve Communities

Omnilimve Docurmeant Sharing and Collaboration
Onilinve Meeaetings

Onilinve Storage and Backup

Dnilirve Trading

Drganizational Email

Paranormal

Parked Domains

Peer File Transfer

Personal Sives

Personal WPN

Photo Search and Images

Politics

Pormograp by

Hate [ Discrimination
Health and Fitness
Instant Messaging
Internet Watch Foundation
ImT-ADM

ImT-AGCOM

Jobs f Employment
Lingerie [ Bikini
Movies

Music

News [ Media
Non-Profits

Nudity

P2P [ File sharing
Photo Sharing

Podcasts

oo000ODODDOOOODODOODO

Portals

0ooOooDooOOOOODDODOODODOOOODOOOOODOOODODOODOODG D

Private IPF Addresses as Host
Professional Metworking

Real Estate

Recipes and Food

Reference

Regional Restricted Sites (Germmany)
Regional Restricted Sites | Great Britain}
Regional Restricted Sites [(Halby)
Regional Restricted Sites [(Poland)
Religion

SaasS and B2B

Safe for Kids

Science and Techmology

Search Engines and Portals

Sex Education

Shopping

Social Metworking

Social Science

Society amnd Culture

Software Updates

Sports. and Recreation
Sareaming MAudio

Swreaming Video

Terrorisan and Vioklernt Extremism
Tobacco

Transportatiom

Trawel

URL Shortenars

Weapons

Web Cache and Archives

Web Hosting

Web Page Translation
Web—basaed Email

Proxy [ Anonymizer
Radio

Religious

Research [ Reference
Search Engines
Sexuality

Software | Technology
Sports

Tasteless

Television

Terrorism

Video Sharing

Visual Search Engines

Web Spam

ooo0oo0o0O0OODODODOOODOODO

Webmail



Migrating Legacy Content Categories
Umbrella has reorganized the content categories and when you go to the All Policies page you will see an option at the
top to begin migrating Legacy Categories to Talos Categories. The Migration Tool will walk you through the whole
process. To begin click on Migrate Content Categories. This will open the Content Category Migration Tool and explain
the Deprecation Phases. Click Next.

You must migrate all legacy content categories. For more information, see Umbrella’s Help.

H Content Category Migration Incomplete. I MIGRATE CONTENT CATEGORIES I

Content Category Migration Tool

o Intro Migrate Confirmation

Cisco Umbrella's content categories are changing so that they align with the content categories used by the rest of Cisco's security products. To
achieve this alignment, you must migrate your current content categories to Umbrella’'s new content categories. Use the Content Category Migration
Tool to achieve this goal. For more information about the about the Content Category Migration Tool, see Umbrella's Help

Phases

The migration to new content categories will occur over the course of the following phases

-j 1 :- Migration Phase: 3 months

=« MNew and legacy content categories can be added and removed from policies.
= New and legacy content categories available to reports.

2 Deprecation Phase: After Migration Phase for 1 year

= Legacy content categories removed from all policies.
= Legacy content categories available to reports.

-: 3 :- Removal Phase: At the end of the Deprecation Phase

= Legacy Categories removed and unavailable.

At the end of the Migration Phase any remaining Legacy Categories in use within policies will be automatically migrated to New Categories. '

Content Category Migration Tool

@ Intro e Migrate Confirmation

Select Umbrella's legacy content categories for migration to Umbrella's new Talos-based content categories. For more information, Umbrella’'s Help.

DOWNLOAD MIGRATION REPORT

E Legacy Category —s New Category DNS Policy Impact « Identity Impact i
(] P2P / File sharing — Peer File Transfer 3 DNS Policies 7 |dentities o
(] Radio — Streaming Audio 3 DNS Policies 7 |dentities e
(] Adult Themes — Adult 3 DNS Policies 7 |dentities o
(] Tasteless — Extreme 3 DNS Policies 7 |dentities o
(] Proxy / Anonymizer — Filter Avoidance 3 DNS Policies 7 ldentities ~
(] Nudity — Non-sexual Nudity 32 DNS Policies 7 ldentities ~
N

CANGEL | BACK | .

You can click on the DNS Policies that will be impacted and it gives more info. On the Migrate screen check the box next
to the Legacy Category to be migrated and click Next.
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Content Category Migration Tool

@ Intro @ Migrate e Confirmation

Do net close or refresh your browser page during the migration process. After Umbrella completes the migration process, legacy categories are available
until the Migration Period ends.

After migration, legacy categories can be manually added to policies until the end of the migration period. Please do not close or refresh your page
during the migration process

I Confirm migration I

=] -

On the Confirmation screen, Check the box next to Confirm migration and Click Migrate.

Content Category Migration Tool

e Confirmation

) Intro @ Migrate

Migration Complete

Selected legacy content categories have been successfully migrated to Umbrella's new content categories.

P

When the Migration is Complete, Click Close. Back under the All Policies screen you will now have a confirmation that
the Category Migration has completed.

"4 Category Migration Complete.
All legacy content categories have been successfully migrated or your policies did not previcusly contain any legacy categories. For more

information, see Umbrella's Help

Below is a list of the Legacy Category and the new Talos Category.

Legacy Category Talos Category
Academic Fraud Cheating and Plagiarism
Adult Themes/ Adult Adult
Anime/Manga/Webcomic Entertainment
Automative Transportation

Blogs Online Communities
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Business Services

Business and Industry

Chat Chat and Instant Messaging
Classifieds Auctions

Drugs Illegal Drugs
Ecommerce/Shopping Shopping

Educational Institutions Education

File Storage

Online Storage and Backup

Financial Institutions

Finance

Forums/Message Boards

Online Communities

German Youth Protection

Regional Restricted Sites (Germany)

Government

Government and Law

Hate/Discrimination

Hate speech

Health and Fitness

Health and Medicine

Instant Messaging

Chat and Instant Messaging

IT-ADM/ IT-AGCOM

Regional Restricted Sites (ltaly)

Jobs/Employment

Job Search

Lingerie/Bikini

Lingerie and Swimsuits

Movies Streaming Video

Music Streaming Audio

News/Media News

Non-profits Non-governmental Organizations
Nudity Non-sexual Nudity

P2P/File Sharing

Peer File Transfer

Photo Sharing

Photo Search and Images

Podcasts Streaming Audio

Portals Search Engines and Portals
Proxy/Anonymizer Filter Avoidance

Radio Streaming Audio

Religious Religion
Research/Reference Reference

Search Engines Search Engines and Portals
Sexuality Adult
Software/Technology Computers and Internet
Sports Sports and Recreation
Tasteless Extreme

Television Streaming Video
Terrorism Terrorism and Violent Extremism

Video Sharing

Streaming Video

Visual Search Engines

Photo Search and Images

Webmail

Web-based Email
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Application Settings

You can also block application categories or specific apps by configuring application settings in your policies.
1. Navigate to Policies > Policy Components > Application Settings.
2. Expand an existing policy or click Add to create a new policy.

3. Select application categories to be blocked, or expand a category to select specific apps.

Applications To Control

Search for an application

v Custormer Relationship Management (CRM)
» E-Commearce
= s GCames

# Brave Frontier Block £
Electronic Arts
Mail.ru Games

Microsoft Xbox Live

Rlintomrin

When some, but not all apps in a category are blocked, the checkbox next to the category shows a dash. When all apps in a
category are blocked, the checkbox shows a checkmark. When no apps are blocked, the checkbox is empty. When settings are

changed and saved in an existing policy, the Application Control Change Summary appears. Click Proceed after reviewing the

summary.

Application Control Change Summary

Please review the summary and changes before [.‘I’i.'-i,'i.‘f.".jl"l:.; to the next step.
The following applications will be blocked:
U Example App, plus 27 more (Anonymizer)

The following policies will be affected:

Default Policy

LY TUIl  PROCEED
it
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https://files.readme.io/c62ca9a-application-control-change-summary-example.png

Block Page Bypass

Block Page Bypass will not be available for any apps blocked at the domain level in Application Settings. The block page will be
a static block page without the ability to enter Block Page Bypass codes.

Note: For more application blocking options, use application settings.

5. (Optional) Check Label application as and select a label if you want to set a label in addition to blocking the app.

6. Click Save.

Security Settings

Now we will adjust the Default Security settings for your network. With Category Settings and
Destination Lists, you create a new one every time you need to create a new policy. With

Security settings, you have this option as well but it is more common practice to see the Default
Security Settings used in 90% of the Filter Policies. If you need to create a new Security Setting,
click the Small Blue Plus Sign at the top of the page.

Navigate to Policies > Security Settings
Select the Default Settings
At the bottom, put a check mark in the box next to any box you want to have blocked on your
network. Most common options that are chosen are:
a. Malware
b. Command and Control Callbacks
c. Phishing Attacks
d. Potentially Harmful Domains
e. DNS Tunneling VPN
f.  Cryptomining
4. Click Save.
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https://docs.umbrella.com/deployment-umbrella/docs/block-apps#section-configure-application-settings

Default Settings e SQratons Ls e "

Setting Name
Default Settings

Ml c._s’e

Websitsz snd othar ssrvers that host mslicious sofrwsrs, drive-by downloads exploits, mobils threstzs and mors.

—  Mewly Sssn Domsins

' Domsing thst have bscoms sotive vary recemtly. Thase are oftsn ussd in new stschke.

Commasnd snd Control Csllbscles
Prawvant compromised devices from communicsting with atteckera” infrestructurs.

Phishing Attschks

Fraudulsnt websitss that sim to trick usera into handing over personal or finsncisl informstion.

—  Dymamic DMS
Block sites thst are hosting dymsmic DMNS contant.

Potentislly Hermful Domsins

Domsins thst sxhibit suspicious behsvior and may be part of an stisck

DMES Tunnsling WPMN
WPMN ssrvicas thst sllow ussrs to disguiss their traffic by tunnsling it through the DNS protocol. Thess can bs ussd to bypsss corporste policies regarding

scossa and dats transfer

$838 33 3

Cryptomining

Cryptomining sllows onrganizstions 1o control cryptominer scesess to mining pools snd walb minersa.

INTEGRATIONS ‘

Policies

You can now create your new District Default Policy. In your Policy List you will see a Default
Policy. This policy will always be at the bottom of your list and it contains the Central Settings
that are managed by the state. You cannot edit or remove this policy.

1. Navigate to Policies > Policy List
2. Click the Blue Plus Sign at the top of the page
3. Since this is a District Wide Default Policy we will be selecting ALL Identities

a. For Student, Faculty, etc policies, click on the AD Groups identity and search for the
corresponding Active Directory Group.
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What would you like to protect?

Select Identities

Zeerch denines 28 Selected s
i+  AD Groups i AD Groups
& ADUsers & ADUsers
[LJ AD Computers [J AD Computers
&, Networks &, Networks
] Roaming Computers [ Roaming Computers
a Mabile Devices & Mobile Devices
Q Sites @ Sites
&, Network Devices & Network Devices

All Identities I

4. Click Next
5. On the “What should this policy do?” page, click Next

vWhat should this pohicy do

Enforce Security at the DNS Layer

a

Inspect Files

a

Limit Content Access

Apply Destination Lists

ADNANCLD SETTMGS ‘

CANCES PREVIOUS m

6. On the Security Settings page, click the drop down and select Default Settings then click
Next

a

a. The Security Settings can be edited from this page by clicking Edit but changes made
here will also be made to every policy that uses the Security Settings component
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that has been chose here.

o Security 0 Cantent e Dstinati o SlockPsgss o Summary

Security Serings

€ idsntne:

poficy are pr tNG:-a securry setng.

Default Settings .

CATEGORIES TO BLOCK  gpy7

U

=.8nd othar servers that host malicous software, drive-by downleads/explaits, mobile threats-and more

U Newly Seen Domains

Domai thave bac

U Command and Control Callbacks

Pravent compromisad devices from cammil

U Phishing Attacks

Fraugulent wetsites thal aim Lo tigh u

U Dynamic DNS

ok sites that are hesting dynam

S content

U Potentially Harmful Domains

Bomains that axhi;

iehavior and may be partofan aitack

U DNS Tunneling VPN

VPN senvice

Hlowr o taffic by tunneiing it thropgh the Dh

ding acoess and datz traps

rega

CANCEL




7. On the Content Page select Custom, then from the drop down on the top right, select

Default Settings and click Next
o Securiny

Limit Content Access
@ Hig}r‘ar

Moderate

Low

Custom

High

Moderate

Low

® custom

Q Contsnt &) Dsstinstion

Categorias ta Block - High

» Aduft Themss
* Alcohol
» Classifisds

« Drugs

» Forums / Messags boards

+ Games

« Instant Meessging
« Nudity

« Photo Sharing

« Proxy / Anonymizer
» Socisl Networking
« \ideo Shering

» Wesapona

Custom Setting

Default Ssttings

Block Pagss Summary

* Adware

» Chat

« Dating

« Fils Storage

« Gambling

« Hate / Discriminstion
« Lingesis / Bikin

« P20/ F

« Pornography

Canwslized Defsult Ssttings

ELECT ALl

Cefsult Setings .
Fsi
Gra Catsgaeris:

sioy’s De Cstsgones

v
Shopping
“REATE NEW SETTIN

Financial Insttutions

& Gambiing

@ German Youth Protec

& Hate/ Disciimination

Himnr

Forums ( Message boards
v Games
tion Government

Heaith and Fitness
@ |In=tant Maszaninn '

8. On the Applications Page choose to use the Default Settings or if you have created a
custom Applications Settings for this specific policy select it from the drop down list and
click Next
a The Applications Settings can be created or edited from this page but changes made here

will also be made to every policy that uses the Application Settings component that has
been chosen here.
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° Security o Content e Applicationz o Destinationz @ 2 More

Control Applications

Select applications or application categeries you'd like to block or allow for the useds in your arganization

Application Settings

| Default Sattings ol

I Dsfault Ssttings I

CREATE NEW SETTING

TE!‘EF':TTET?P BPPICETon

[ » AdPublighing

3

»  Anonymizer Block

[ » Applicstion Devslopment snd Tssting

[] » Buszinses Intsligencs

O > CEM

O % Cloud Storage

[ » Collsborstion

% Paemnan

CANCEL
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9. On the Destinations Page, your Global Block and Global Allow Destination Lists will
already be populated here. Put a checkmark in the box next to your Default Allow and
Default Block list on the left hand side. You will see them populate in the area on the right
hand side along with the Global Allow and Global Block lists.

a. Your Global Destination Lists will be in every policy and cannot be removed so be
careful with your Destination Lists.

9. Click Next
° Sscurity g Content e Destinations "3 Bicck Pages Summary
ADPHY JESTNGTION LISTS ADDNEW UST
Q ze: 2 Allow Lists Applied REMOVE ALL
s Showing: Allists v 5 Total @ Dafault Aliow
¢ & Dasfault Allow % Global Allow List
¥ & Dsfault Block 2 Block Lists Applied REMOVE ALL
@ Globs! Allow Lisz @ Desfauit Block
® Global Biock List @ Glotal Block List
@ network list

4

cance [ previous | D

10. Choose weather you want to use the Umbrella Default Appearance or Custom Appearance then
click Next.
© secuwy Conrtent ° Destinations o Block Pages Summsry

All Destination Lists

(4]
O

9]
o
()
il

)
)
)]
l!"

()

Use Umbrella's Default Appearance

(@ Use a Custom Appearance

Centralized Default Settings

11. Name your policy District Default Policy and verify that all of your settings are correct.
Once you are done, click Save.
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g Security Q Content G Desatinations Q Bicck Psges 0 Summary

S i [ I T
Ly

(4]

Policy Nams

[] 28 ldentities Affected U 4 Destination Lists Enforced

‘“] File Inepection Enabled
(J Security Setting Applied: Default Sattings 4

l’) Custom Block Page Applied

U Content Setting Applied: Dafault Settings

The policy that was just created will be the Default Policy for the District. If a user does not
authenticate against Active Directory, that user will be filtered according to this policy. That is why
it is recommended to make this policy so strict and also why every Identity is selected at the
beginning of creating this policy.

Follow these steps again to create a Student, Faculty, and Administration policy but do NOT select
every ldentity. Instead navigate into AD Groups and search for the corresponding Active
Directory Group. You will need to create new individual components for each new policy.

OpenDNS Policies are a top down process. This means that when a user tries to authenticate to a
policy, it will start at the top of the list and work its way down. That is why your most LEAST
restrictive policies, 1.E. IT or Administration, should be at the top and your MOST restrictive
policies, 1.E. Students and the District Default Policy, should be at the bottom.

Policy Advanced Settings
After the policy has been created, clicking on the policy again will display page that is very

similar to the summary page seen during the last step of the policy creation. The policy can be
edited here as required. At the bottom is a drop down called Advanced Settings.

47|Page



District Default Policy

Policy

U

U

0 identities

)

ettings Feb 5, 2018

Nams

0 Identities Affected (] 2 Destinstion Lists Enforced

Security Setting Appliad: Default Settings

File inspection Not Enabled

Content Setting Applied: Default Settings C] Custom Block Page Applied

=Sl o Seh s m

Clicking the Advanced Settings drop down will display a few advanced features.

1.
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The first option is to Enforce SafeSearch. SafeSearch is an automated filter of pornography
and other offensive content that’s built into search engines. If anyone enters an inappropriate
or suggestive phrase, no results will be returned that could be considered unsafe or

problematic. This method of enforcing SafeSearch is supported for Google, YouTube, and
Bing.

SAFESEARCH

Enforce SafeSearch
Enforce SafeSearch for gqueries sent to supported search engings Leamn More

The second option listed is Allow-Only Mode. This option disables any block settings in
the policy because it will block every single web connection by default. With this option
enabled, users who authenticate to this policy will ONLY be able to access the websites that
are listed in the Allow Destination Lists. This is useful for students who have broken the
rules to many times. An Active

Directory group can be created called No Internet. A Policy would then be created using
only that AD Group as an identity. This policy will then be moved to the very top of the list.
If a student needs internet access for specific sites for class work but are no longer allowed
to access anything else, then they can be moved to the No Internet Group in Active
Directory which will cause them to authenticate to this policy and only be allowed access to
the websites listed in the Allow Destination Lists.

Allow-Only Meode



3. The final option is Logging. This is set to Log All Requests by default and should remain
that way on every policy. Without this option enabled, Activity Search will no display any
results resulting in no longer having the ability to pull reports.

Deploying Umbrella Certificate

Advanced Umbrella features, such as IP Layer Enforcement and the ability to block your own custom URLs
require that the Cisco Root CA be installed locally.

In addition, by installing the certificate, you avoid a common problem with block pages that your users may
encounter. When HTTPS enabled domains are blocked by your policy, Cisco Umbrella presents a block page to
you which is also served over HTTPS. This block page is encrypted with a certificate signed by the Cisco Root
CA. In order to avoid certificate errors when accessing the block page, you must install the Cisco Root CA in
your browser, or if you have a network of computers, in your users' browsers.

Why Deploy Certificate?

Umbrella’s Block Page and Block Page Bypass feature present an SSL certificate to browsers that make
connections to HTTPS sites. The certificate will match the requested site but will be signed by the Cisco Root
Certificate Authority (CA). If the Cisco Root CA is not trusted by your browser, an error may be displayed.
Typical errors include "The security certificate presented by this website was not issued by a trusted certificate
authority" (Internet Explorer), "The site's security certificate is not trusted!" (Google Chrome) or "This
Connection is Untrusted" (Mozilla Firefox). Although the error is expected, the messages displayed can be
confusing and annoying and you may wish to stop them from appearing.

To avoid these errors entirely, install the Cisco Root CA in your browser, or the browsers of your users (if
you're a network admin). This can be done on a per-browser, per-machine basis for personal use or small
deployments. For larger deployments, an automatic installation through Group Policy (GPO) can be done. Note
that the automatic installation through GPO will only work for users with Internet Explorer, Edge, or Chrome
on Windows systems. As such, if your network includes some users who use Firefox or Safari browsers, and for
users on non-Windows operating systems, the manual installation procedures must be followed.
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Download Certificate

In the Umbrella console under Deployment there is a link to download the root certificate which is necessary for
proper processing of the Umbrella block page for destinations which are https:// encrypted sites. This certificate
is also necessary for the option of decrypting DNS requests related to https encrypted sites.

<Back To Muli-org Consoe Q I -

Umbrella

e alvali. Deployments [ Configuration

asce Root Certificate

Deployments

Core ldentities
Get Started
et

Umbrslls's Block Pagse featurs presenta sn S5L certificsts to browsers thet makse connsctions to
blocked sites. The certificats will match the reguested site but will be signad by the Ciaco Root
Certificats Authority [CA).

DOWNLOAD CERTIFICATE

To verify your downlosd, check the Cizco certificate’s SHA1 thumbprint end ensure that it matches
CH08:11:32:E9:ADFBAD:3E:33:93:2A°E6:0A:5C:BF-AS:30°E8:24

For inatructions for Windows, OF X end Linux and across Chrome, Firsfox, and Safari on those
plstforms (ss applicabls), including guidance with GPO. plssss rsad hera:
https://docs.umbrella.com/product/umbralla/rebrand-cisco- certificate-import-information

TROUBLESHOOTING

\coount Exceptions

Certificats

This certificate can be pushed to all windows workstations with group policy, and to Chromebooks with Google
admin. You can use the Apple MDM to push it to iOS devices.

Download the certificate to a network location that is accessible to the device from which you will be
implementing the distribution.
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Group Policy Management Editor =8| X || Server Manage
File Action View Help
9 s ol e Bm
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i Ay 4 1 [J4 » ThisPC » Downloads v | [ Search Dow 5

Issued By

this view.

i§ Ap Organize ~  New folder = v 0@
18 DH ~ -

Favorites Name Type
& DN

- I Desktop # Cisco_Umbrella Root CA
g File J4 Downlaads

Security C

B Hyp % Recent places

e This PC
I Deskiop
Documents
4 Downloads M
b Music
& Pictures
B Videos

% Local Disk (C)
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Deploy Certificate with GPO

To deploy the certificate to Windows devices using group policy, follow the instructions below:

1. On a domain controller in the forest of the account partner organization, start the Group Policy

Management snap-in.

=] Server Manager - @ x

Server Manager * Dashboard @1 F Mamsge 10

'WELCOME TO SERVER MANAGER
§ Local Server | 3 Group Policy Management = | E -

All Servers |l File Action View Window Help x
AD DS e A k| Xg
71 DHCP [ Group Policy Management Default Domain Policy -
2 DNS 4 fh Forest: TESTDOMAIN.local Scope | Details | Settings | Delegation | Status |
4 (%, Domains ”
&5 File and Stor 4 54 TESTDOMAIN.Jocal Links
BB Hyper-v 5/ Default Domain Policy Display lnks inthis location [TESTOOMAINJocal v
i/ Local admin The following sites, domains, and OUs are linked to this GPO
b 1 Domain Controllers -
» &1 Lsh Computers Location Enforced Link Enabled F
E puter [ TESTDOMAIN Jocal No Yes 1
4 [ Group Policy Objects
= Default Domain Controllers Polis < m 3 Hide
=/ Default Domain Palicy )

1=/ Local admin Security Filtering
b [ WM Filters

7 The ssttings in this GPO can only apply to the following groups, users, and computers:
1 L] Starter GPOs

% st Name +
b b LA ottes 8 Autherticated Users
! Group Policy Modeling
roup Policy Results
| Add... | ‘ Remove Properties
s
WMI Filtering
This GPO is linked to the following WM fiter:
| <none> v Open
< m >
BPA results BPA results

ISILA =D s
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2. Find the Default Domain Polity Group Policy Object (GPO). Right-click the GPO, and then click Edit.

=] Server Manager - a3 x

Server Manager * Dashboard G Manage  Tools

Local Server |3 Group Policy Management \;l_-
AllServers | & File Action View Window Help
AD DS == B|X @
DHCP |2, Group Policy Management Default Domain Policy _
DNS 4 i) Forest TESTDOMAIN.Jocal Scope | Details | Settings | Delegation | Status |
4 [Z4 Domains .
File and Stor 4 54 TESTDOMAIN.Jocal Links )
B Hyper-v %/ Default Domain Policy Display lnks in this location [TESTDOMAINocal v
s/ Local admin The following sites, domains, and OLls are linked to this GPO:
I (21 Demain Controllers =
: cation orce: ik Enable
= Locat Erforcsd  Link Ensbled f
= P 3 TESTDOMAIN Jocal No Yes 1
4 [ Group Policy Objects
= Default Domain Controllers Poli[| |~ - S fide
-] Default D nat ,
L=/ Localad Edit... ha
b [ WMI Fiters GPO Status * |5 GPO can only apply to the following groups, users. and computers:
X Sbt 3 Starter GROs i -
@ Sites L
[ i Group Policy Modeli | Restore from Backup... e
& Group Policy Results Import Settings...
sevefeport. 1
View 3 1
Mew Window from Here
d to the following WM fiter
Copy v Open
< n Delete
Open the GPO editor Rename
Bl S EPA results
Help

CIETeT o] Twe |

3. In the console tree, open Computer Configuration\Policies\Windows Settings\Security
Settings\Public Key Policies, right-click Trusted Root Certification Authorities, and then click

Import.

=1 Group Policy Management Editor =&
File Action View Help
e3> @ EE

- Defeult Domain Policy [WIN-305BJISFOB.TESTDOMAIN.LOCAL ~
4 & Computer Configuration

= Default Domain Policy [WIN-30SB/I6TFO6.TESTDOMA

Select an item to view its description,  Mame

Pol h
9 4 . D';'E;W et {8 Computer Configuration L
oftware Settings
-+ B Windows Sminggs #% User Configuration
eny -
b [] Name Resolution Policy
s Scripts (Startup/Shutdown)
P Security Settings

[ Account Policies

4l Local Policies

| EventLog

b L& Restricted Groups

b (& System Services

b |4 Registry

b (& File System

1> 4/ Wired Network (IEEE 802.3) Policies

b ] Windows Firewall with Advanced Security
| Network List Manager Policies

I Zaff Wireless Netwark (IEEE 802.11) Policies -

4[] Public Key Policies

Encrypting File System

Data Protection

13
3
3

BitLocker Drive Encryption
BitLocker Drive Encryption Network Unlock
*| Automatic Certificate Request Settings

| Trusted Root Certi

| Enterprise Trust [z
| Intermediate Certi All Tasks v
| Trusted Publisher
“ Untrusted Certific P
7| Trusted People Help
b (] Software Restriction Palicies
b (] Network Access Protection v r
< [ > | Edended ( Standard




On the
On the

Next.

Welcome to the Certificate Import Wizard page, click Next.

File to Import page, type the path or browse to the appropriate certificate files and click

E Group Policy Management Editor — |8 X | Serv Group Policy Management Editor =8| X ||Serverh
File Action View le Action View Help
o=z H=E
A esnied Ta > Issued By 4 [ Polici ~ M issued 10 Issued By
¥ = . ]|
Y this view. .o this view.
v @ 2+ Certificate Import Wizard o (R Open -
4 y 1 [Js » ThisPC b Downloads v @] [ Search Downloads 2|
File to Import
Specify the file you want to import. Organize New folder 0 e
Favorites 2 Name Date modified Type
File name: I Desktop # Cisco_Umbrella_Root_CA 10/4/2018 223 PM  Security C
C\Users\Admm\stratnr\ann\nads\C\scn_umbrel\a_Rnnt_CA.cer‘ [ Bronse... Js. Downloads
%5 Recent places
Note: More than one certficate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS, #12 (.PFX,.P12) & This PC -
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P78) ly Desktop
Microsoft Serialized Certificate Store (.SST) Documents
J Downloads N
b Music
k Pictures
B Videos
&, Local Disk (C)
[ P g il >
1 File name: | Cisco_Umbrella_Root_CA v| [certticate File (vcercrty v
, 1 Network Access Protection b (1 Network Access Protection
v [ Application Control Policies v v [ Application Control Policies v
< m > < m > il > < m >

6. On the Certificate Store page, click Place all certificates in the following store, and then click

Next.

Group Policy Management Editor

\ction View Help

(=} Se

~ Issued By

-| this view.

1 @ .+ Certificate Import Wizard

e 10

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certficate store, or you can specify a location
for the certificate.

Automatically select the certificate store based on the type of certificate
(@) Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities

v ) Network Access Protection
» 1 Application Control Policies
m

Root Certification Authorities store contains no certificates.
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. On the Completing the Certificate Import Wizard page, verify that the information you provided is

accurate, and then click Finish.

h Group Policy Management Editor -8 x |
File Action View Help
e znmo/czBm

ol NPT Issued By

B (€) = Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate vl be imported after you dick Finish.

You have speafied the following settings:
T T Trusted Root Certification Authorities
Content Certficate
C:\Users\Administrator Downioads\Giseo_Umbrella

e e =
Network Access Protection
lication Control Policies

u

rusted Root Certification Authorities store contains no certificates.

Deploy Certificate to Chrome Devices with Google Admin

To distribute the certificate using Google Admin, do the following:

Sign in to the Google Admin console.
Click Device management.

On the left, click Network.

Click Certificates.

(Optional) On the left, choose the organizational unit where you want to add the certificate.
Note: The top-level organization is selected by default to give all users (including those in
suborganizations) access to any added certificates.

Click Add Certificate.

7. Choose the certificate file to upload and click Open.
Note: DER-encoded certificates are not supported. Chrome devices only accept PEM format.

8. (Optional) If the certificate will be used as a root CA for an SSL-inspecting web filter or to allow the
browser to validate the full digital certificate chain of servers, check the Use this certificate as an
HTTPS certificate authority box.

9. Click Save and then Done to confirm.

Verify the CA on managed Chrome devices

a N~

o

1. Go to chrome://settings/certificates.
2. Click Authorities.
3. Scroll down to see the newly-added CAs.
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CAs set up in your Admin console are highlighted as follows:

Certificate manager

Your Certificates Servers Authorities Others

You have certificates on file that identify these certificate authorities
certSIGN
certSIGN ROOT CA

Chromedepioyment

Chromedeployment fil)

This certificate has been installed by your system

administrator Yority

With respect to your iOS devices, contact your management provider or install each device

with the certificate individually.

ByPass User
Setting up your Block Page Bypass

An important step when configuring policies is to ensure that you're giving the right information to your users if
they are blocked under Security or Content categories. As the Umbrella administrator, you may wish to exempt
users from being blocked during certain times and you can set up the rights to do that as well.

Some helpful terms to know:

o Block Page—The page that's displayed in the browser when a user of your Umbrella service tries to go to a
website that's been blocked under the category defined by the policy for the Identity that user falls under.

« Block Page Bypass—The method by which certain users who have been given special authority can bypass
a normal block page. There are two ways you can bypass a block page: having a user account (a bypass user)

or having a special code (a bypass code).

« Block Page Bypass User—A special user account that gives the rights to certain individuals or a group of
individuals to go to blocked sites while still being part of the enforcement given to the larger policy group to

which they they belong.

« Block Page Bypass Code—A code that can be given to individuals or groups of individuals to allow them to
go to some or all blocked websites until such time as the code expires.

Not all categories can be bypassed. If a user is blocked for a Security or Malware category, the site is
considered malicious and should not be accessed under any circumstances. If you think a domain shouldn't be

blocked, please email us at security-block@opendns.com.
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If you'd like to know more about a block or have us review it in more detail, open a case by emailing umbrella-
support@cisco.com with information about the domain and our support and security teams will review.

The following policy settings can be bypassed:
o Content category blocks
o Destination list blocks—these are destination lists you've created

o The phishing security block

Setting up a Block Page Bypass User

A "Block Page Bypass" user is special username and password that can be given to one or more users in order

to provide them with rights to bypass pages that are typically blocked through policy settings. This user can be
thought of as being a special set of rights that are given to individuals as required. The Block Page Bypass user
has no ability to log into the dashboard or do any administrative functions other than bypass blocked sites.

1. Navigate to Admin > Bypass Users. Alternately, the block page bypass user can be created by editing the
Block Page Appearance in the summary of a policy. The edit for this setting is in the lower right corner of
the policy summary.

Add New Bypass User

Bypass User Description

New Bypass User

Bypass User

Select a bypass user

This bypass user can:

® Bypass everything Bypass specific categories and destination lists

2. From the Bypass User drop-down list, choose a <user>.

When a block page shows up, the user then enters their credentials and bypasses it.
Select how the user can bypass a block page.

Click Save.

B w

The "Block Page Bypass™ user gives the rights to certain individual people, or a group of people to go to
blocked sites while still being part of the enforcement given to the larger policy group they belong to.
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Create New Bypass User
This user will be able to bypass blocked destinations.

Bypass User Description

Matt's Bypass user
Bypass User

Matt Prytuluk -

This bypass user can:

Bypass everything @ Bypass specific categories and destination lists

Bypass Categories

ass Destination Lists
B Academic Fraud

Adult Themes
Adware
Alcohol

Anime/Manga/Webcomic

To setup a brand new bypass user, that is, an account with rights to authenticate against the block page and
continue browsing, first, create the user with the Block Page Bypass role.

1. Navigate to Admin > Accounts and click the + (Add) icon.
2. Choose Block Page Bypass from the drop-down list.

Newl Bypass user BPB User 4| (UTC-07:00),

newbypass@cisco.com s aeeee

3. Click Create and in the pop-up modal click Yes to configure Block Page Bypass settings for the user.
The Add New Bypass User page opens (Policies > Bypass Users).

Configure this Block Page Bypass Account

You have created an account that is a Bypass User role. Would you like to configure this

account's Block Page Bypass settings now?

NO THANKS YES

4. If you click No Thanks, you can change the settings for the user you've created under Admin > Bypass
Users or add the settings as part of the policy summary as described earlier.
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5. Add a new bypass user and click Save.

Add New Bypass User

Bypass User Description

New Bypass User

Bypass User

Select a bypass user v

This bypass user can:

® Bypass everything Bypass specific categories and destination lists

Creating a Block Page Bypass Code

A Block Page Bypass Code is a code that can be given to users through email, instant messenger or the phone to
allow an instant bypass of a particular blocked page.

1. Navigate to Admin > Bypass Codes and click the + (Add) icon.
You can also access this page from the Summary page of a policy. Click Edit for the Block page applied.

Policies / Block Page Settings OpenDNS Dashbeard

Bypass Codes ©

Add New Bypass Code

Bypass Code Name

New Bypass Code

This bypass code can:
@ Bypass everything Bypass specific categories and destination lists
This bypass code will expire on:

2022-06-25 [is] 11:59 PM -

2. Set the code to either allow access to all sites or a subset of the content category or destination lists you've
defined.

The code can be set to expire at a day in the future and at an hour of that date.

4. Click Save.

w

Removing a Bypass Code

1. Navigate to Policies > Block Page Settings > Bypass Codes.
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2. Expand the code you want to delete and click Delete.

Legal team bypass code OABNT Everything

Bypass Code Name
Legal team bypass code
Code: 0A6N1

This bypass code can:
® Bypass everything Bypass specific categories and destination lists
This bypass code will expire on:

2018-02-03 i 11:59 PM

DELETE

Applying Bypass Codes/Users to a policy

Before you will be able to use your new bypass user or bypass code, you must first link it to a policy!
1. Navigate to Policies > All Policies

2. Click on the policy you want to apply the bypass user or code to.

3. Click Edit under the Block Page that is Applied.

4. Expand either Bypass Code or Bypass User and select the user or code you want to apply.

5. Click Set & Return, then SAVE!

Interacting with a Block Page As a User

As an administrator, you can preview the block page; however, not all elements of the page will be accurately
reflected in Preview Mode. This is a problem that's being worked on and will change in the future.

As a standard (non-bypass) user, if you were to go to a website blocked under your Umbrella policy, you would
see a standard block page like this. This example has a custom block page message that includes a link to an
acceptable use policy from this organization, as well as a custom logo for this organization.

Note:

Keep in mind that the block page bypass will not work with domains blocked due to malicious activity (such as
malware or phishing). You can only access the bypass block page if the domain was blocked due to content
category settings or domain block lists. The "Admin" link will not appear if the domain was blocked as
malicious activity.
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At the bottom of the block page, there are two hyperlinks that may appear:

e Contact your network administrator—Allows a user to email the administrator if the user thinks the block

is in error.

e Administrative Bypass—This allows a user with a bypass user or a code to access the part of the page that
asks for that information. Below is the same block page for a policy that has both a user and a code

configured for it.

asco Cisco Umbrella

This site is blocked.

familydoctor.org

» Administralive Bypass

Sorry, familydoctor.org has been blocked by your network administrator

> Diagnostic Info

Terms | Privacy Policy | Contact

After clicking on the Administrative Bypass link you will be able to authenticate with either your Bypass User

or Bypass Code

asco CISCO Umbrella

This site is blocked.

familydoctor.org

~ Administralive Bypass

Block Page Bypass is a feature that allows authorized users to bypass this block page. If you're
authorized, you can log in with your Cisco Umbrella credentials. Otherwise, you can use a temporary

code provided by your network administrator.

Email Address (or Username) Bypass Code
—

L ]

Forgot Your Password?

Your IP address is 66.204.79.150

After you enter your email/password or bypass code and click bypass you will see the following box
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asco CISCO Umbrella

You are now signed in.

Continue browsing at famitydoctor.org

Terms | Privacy Policy | Contact

You can now click on Continue browsing at <URL> and continue to the site. A popup box will come up and
needs to stay open until you are finished with the bypass. When finished click Log Out to end your bypass
session.

atfrer]n

asco CIsco Umbrella

Block Page Bypass
‘You are currently using bypass coda TT**.

This code expires in 11 hours.

Terms | Privacy Policy | Contact
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Cisco Security for Chromebook Migration

Reference: https://support.umbrella.com/hc/en-us/articles/13818088861588-Updated-Prepare-for-Upcoming-Changes-
Umbrella-Chromebook-Client-and-SWG-Umbrella-Chromebook-Client

NOTE: The old Umbrella Chromebook Client will still be supported until June 2025. Make sure you are fully migrated
over to the new Cisco Security for Chromebook App before June 2025.

NOTE: Once migrated to the new app you will no longer be able to view the internal IP address of Chromebooks in
Activity Reports.

Prerequisites:

To enable DoH and SWG protection on Cisco Secure Chromebook client, the following prerequisites must
be met:

e You must have Umbrella login credentials.

e You must have a Google Workspace admin account to push Cisco Security for Chromebook client
to all the Chromebook devices.

e We recommend that you synchronize Google Workspace identities with Umbrella to apply the

Google Workspace user and organizational unit-based policies. For information about integrating
the Google Workspace identities, see Integrate Google Workspace Identities.

e Chrome OS 110 or later is required to enable DoH-based DNS layer protection on Chromebooks.
e Chromebooks must not be in Kiosk mode.

o For DNS layer protection, ports 53 UDP and 443 TCP must be allowed. For SWG layer protection,
port 8888 (TCP) must be accessible to 146.112.0.0/16 and 155.190.0.0/16.

e You must have access
to https://reqgistration.polaris.gg.opendns.com, https://sync.hydra.opendns.com, and https://doh.um
brella.com.

e Chromebooks must be connected and logged in.

e Install Cisco Umbrella root certificate on your Chromebooks to avoid certificate errors when
accessing an Umbrella block page. For more information on this installation, see Install the Cisco
Umbrella Root Certificate.

For more information about how to push the Umbrella root certificate from the Google admin
console to all your Chromebook devices, seeSet up TLS (or SSL) inspection on Chrome devices.

e Inthe Google Workspace Admin console, you must disallow the incognito window. From
the Incognito mode menu, choose Disallow incognito mode. For more information, see Incognito
Mode in Chrome Enterprise and Education Help.
For SWG, you can optionally configure the DNS servers on your network to forward DNS traffic to
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Cisco Umbrella. This configuration provides the most accurate selection of SWG Data Center
locations. For more information, see Point your DNS to Cisco Umbrella.

e Third-party web filtering or web proxy solutions may interfere with the SWG proxy setup of
Umbrella Chromebook client. We recommend that you remove these solutions before deploying
Cisco Security for Chromebook client.

e The following devices and operating systems are not supported:
o Chrome browser on OS X, Windows, and Linux.

o Devices running variations or third-party distributions of ChromeQS, such as Neverware
CloudReady.

e Network requirements

Port and ..
Protection Protocol Source / Destination Notes
Configured DNS
DNS and SWG Layer 53 (UDP) - resolvers should be
reachable.
Registration. HTTPS. Used for
DNS and SWG Layer 443 (TCP) 8ISt o .
polaris.qg.opendns.com registration of client.

HTTPS. Used to synchronize device
DNS and SWG Layer 443 (TCP) sync.hydra.opendns.com details and to fetch
configuration.

DNS and SWG Layer 443 (TCP) doh.umbrella.com HTTPS. Used to resolve DNS requests.
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Cisco User Management for SSE Setup (Google Workspace Integration)

1. Loginto your Gsuite Admin Console at https://admin.google.com

2. Navigate to Apps/Google Workspace Marketplace apps/Apps list.

© Admin

m Home
OB Dashboard
y & Directory
» [0 Devices
- i Apps
Overview
» Google Workspace

Additional Google services

Web and mobile apps

. Google Workspace
Marketplace apps

Settings

3. Search for “Cisco User Management for SSE” in your Domain Installed Apps.
If not already installed then proceed to step 4.
If already installed then proceed to step 7.

= o Admin Q, search for users, groups or settings
- H apps A Google Workspace Marketplace Apps
Overview
» Google Workspace Google
Additional Gaogle services Workspace

' @
vk

» B

Web and mobile apps Marketplace
Google Workspace

Marketplace apps .
All users in this account

Apps list
Group:
Settings
LDAP Organizational Units
Security -
Search for organizational units
Reporting
Billing -

4. Click on “INSTALL APP.”
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Showing apps for users in all organizational units INSTALL APP

Domain Installed Apps (4)

App Name

Adobe Actobat: PDF edit, convert, sign tools

‘ BetterCloud
ﬁ Cisco User Management for SSE

Rows per page: 50

Allowlisted Apps

ALLOWLIST APP

Distribution

ON

ON

oN

ON

a 8 @

USER INSTALL SETTINGS

Blocked Apps
Detat
Drive app
Web app
Web app
Web app, Drive app
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https://admin.google.com/

= O Admin Q_ search for users, groups o settings a2 O®

Google Workspace Marketplace Apps

Showing apps for users in all organizational units ALLOWLIST APP USER INSTALL SETTINGS
» Google Workspace Google
Additional Google ser Workspace i nstated Apps (4 oniieted Ao
Web and mobile apps Marketplace
All users in this account oN o
Apps list
) v oN Web app
Setlings
LDAP Organizational Units ~ oN Web app
v @ securlty § aN Web app, Drive app
al units
» il Reporting
perpage: 50 Page 10f 1
» B silling

5. Inthe search bar search for “Cisco User Management for SSE” and click on the App.

= o Google Workspace Marketplace Q I 1sco User Management for SSE I X

Q Home

o’ Recommended for Goo...

3£ Al filters Works with = Price = Internal apps

Search results for Cisco User Management for SSE

- Editor's choice Google doesn't verify reviews or ratings. Learn more about reviews and resulis &5

Intelligent apps

Work from everywhere @

Business essentials

Apps to discover

Cisco User Managemen...

@ Built by Google

v [il] Top charts

* 12 & 36M+
Most popular

Top rated
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6. Click Admin Install, then CONTINUE, then check “l agree...” and finally FINISH.

Cisco Umbrella Auth...

Cisco Authorization application for granting access to
Ciseo Umbrella Cloud system,

By C a2
Uistingupdated: Aprii 14, 2023

A This i i be installed. Learn more &3

okt r21 @ & 35Me

© Admininstall

You are about to install this app for an entire
Google Workspace organization, or for
specific organizational units or groups. All
users of the Google Workspace organization,
organizational units, or groups you select will
have access to this app.

It may take up to 24 hours for this app to be
installed for your entire Google Workspace
domain, organizational units, or groups.
Cisco User Management for SSE needs your
permission in order to start installing.

By clicking Continue, you acknowledge that your

information will be used in accordance with the terms of
service and privacy policy of this app! n

CANCEL

You are granting Cisco User Management for SSE the right
1o access your data:

©  view domains related to your customers ®
©  view organization units on your domain ®
©  seeinfo about users on your domain ®
@  See your primary Google Account email address @
@ 5S¢ you personal nfo, including any personal infoyoue 7y

made publicly available

Install the app automatically for the following users

[ o s

(O Certain groups or organizational units
Select users in the next step

agree to the application's Terms of Service, Privacy
olicy, and Google Workspace Marketplace's Terms of
ervice

CANCEL FINISH
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Once installed you should see the following screen with Status: Granted in green. If you do not then click on

“Grant access” to finish the setup. Then proceed to the Umbrella Setup section of this guide.

= @O Admin

@ Home
O3 Dpashboard
o

» & Directory

» [0 Devices

Apps
Overview

» Google Workspace
Additional Google services

Web and mobile apps

Google Workspace
Marketplace apps

Apps list
Settings
LDAP
» @ secury
» 1l Reporting
» B slling
» @ Account
@ Rules

& Storage

[ send feedback
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Q  search for users, groups or settings

Apps > Ad stall Google Worksp

etplace apps > Cisco User Management for SSE

& Back tolist O cor for Cisco User

Cisco User Management for
ﬂ o User Access

Gisco Umbrella

w organizational units and group:

Platform: Google Workspace Marketplace
Type: Web app

ON for 1 organizational unit

[} VIEW APP LISTING

B UNINSTALLAPP

OAUth Seopes

for al

or organizational units. Lear more

OAuth Clients

These are the Google service APIs (OAuth scopes) that Cisco User Management for SSE is requesting.

- © cooseviorkspace Acmin

>
ttp:

View domains related to your customers

readoniy

View organization units on your domain

hitps://www.googleapi

a

See info about users on your domain

readonly

hitps://www.googleapis.com/auth/admin directory.user readonly

~ @ other

See your primary Google Account email address

https://ww.googleapis.com/auth/userinfo.email

https://www googleapis com/auth/userinfo profile

‘See your personal info, including any personal info you've made publicly available

evoke access

COLLAPSE ALL

Granted

Granted

Granted

Granted

Granted



Umbrella Setup

1. Login to the Umbrella Dashboard at https://login.umbrella.com/

Forgot password? | Single sign on

CIscoO
.--! Cisco Umbrella
p—
—
‘: Emall Address
—
- \l
"’"1 Password
et ’
— &
———'—? 2
—

Sign Up for a Free Trial

2. Navigate to Deployments/Core Identities/Chromebook Users

Cisco Umbrella

Deployments
Core Identiues
Networks
Network Devices
Roaming Computers
Mobile Devices

Chromebook Users

Users and Groups
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3. Click configure in the top right corner of the webpage.

@ information Chromebook Users @ ———®

Fam
|\{3}/|

Configure

A Chromebook User identity represents the integration of 2 Chromebook device with Umbrella. To integrate
Umbrella with a Chromebook device, deploy the Cisco Security for Chromebook client. Once deployed, this client
lists your Chromebook users as Umbrella identities that can be added 1o the DNS and Web policies. To get

started, click Configure. For more information, see Umbrella’s Help.

4. Define a salt value by clicking “Configure” on the right side. NOTE: Once the value is set it cannot be changed!!!

Cisco Security for Chromebook Configuration

To deploy the Cisco Security for Chromebook client, you must first define the Salt. Salt is
required to enable the DNS Security using DoH (DNS over HTTPS) on Chromebooks. Next,
download the Chromebook Client Configuration File that contains the information required by
the client 1o operate with Umbrella. To sync user identities from Google Workspace, it is
recommended 10 integrate Google Workspace with Umbrella. During the deployment, the
Chromebook extension is added to the Google Admin Console. For more information, see
Umbrella’s Help.

Salt Value Required
To continue using the DMNS Security on Chromebooks, you must configure a Salt value and migrate
to DoH. For more information, see Umbrella's Help.

1. Deflne Salt

configured =——————— CONFIGURE

2. Chromebook Cllent Conflguration Flle

ChromebookConfig.json DOWNLOAD

3. Google Workspace Integration

It is recommended to sign in using a Google Super Admin account to sync Google
Workspace identities with Umbrella.
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5. Enter a value for the Salt then click “save.”
The Salt value must be between 8 and 32 characters and can contain letters and numbers but NO special

characters.

Configure DoH Salt

Caonfigure the Salt to enable DNS Security using DoH (DNS over HTTPS) on Chromebaoks.
The Salt is used 1o hash Chromebook identities before they are sent 1o Umbrella. For more
nformation, see Umbrella’s Help.

Salt Value

© The Sait value cannot be changed once confirmed.

| CANCEL ‘

6. Once the Salt is configured there will be two Template URLs created, copy these to a text file and make sure to
notate which one is the Default DOH Template and which one is the Managed Guest/Public Session DoH
Template. You will use the Default DoH Template later for your managed Chromebooks. The Managed
Guest/Public Session DoH Template is only used for Managed Guest sessions.

1. Define Salt
Salt Value
Salt12345

@ You must raise a support ticket with Umbrella to update the salt value

Default DoH Template \

u https://doh umbrella.com/identity/v1/20292:4f444e530100000800254542400... COoOPY

Managed Guest/Public Session DoH Template \

u https://doh.umbrella.com/fidentity/v1/20292:4f444e53010000080025454 2400, | copy
Default

https://doh.umbrella.com/identity,/vl/ 20292 4FfA40e030]. . . . .. e

Managed Guest
https://doh.umbrella.com/identity,/vl/20292:4Ff444e53010080880. . . . . . . .. .o e
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7. Download the Chromebook Client Configuration File and note the location you downloaded it to. This Json file
will be used later when installing the new Cisco Security for Chromebook app. If you lose the file or need to
redownload it, you can always return to this webpage later.

Cisco Security for Chromebook Configuration

To deploy the Cisco Security for Chromebook client, you must first define the Salt. Saltis
required to enable the DNS Security using DoH (DNS over HTTPS) on Chromebooks. Next,
download the Chromebook Client Configuration File that contains the information required by
the client to operate with Umbrella. To sync user identities from Google Workspace, it is
recommended 1o integrate Google Workspace with Umbrelia. During the deployment, the
Chromebook extension is added to the Google Admin Console. For mare information, see
Umbrella’'s Help.

Salt Value Required
To continue using the DNS Security on Chromebooks, you must configure a Salt value and migrate
to DoH. For more information, see Umbrella's Help.

1. Deflne Salt

0 e configured CONFIGURE
2. Chromebook Cllent Conflguration Flle
ChromebookConfig.json - DOWNLOAD

3. Google Workspace Integration

Itis recommended 10 sign in using a Goagle Super Admin account 10 sync Google
Workspace identities with Umbrella.
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8. For Google Workspace Integration click “Sign in with Google” and sign in using a Gsuite Super Admin account
tied to your domain. Once completed you should see your Super Admin email address listed.

Cisco Security for Chromebook Configuration

To deplay the Cisco Security for Chromeboaok client, you must first define the Salt. Saltis
required 10 enable the DNS Security using DoH (DNS over HTTPS) on Chromebooks. Next,
download the Chromebaook Client Configuration File that contains the information required by
the client 1o operate with Umbrella. To sync user identities from Google Workspace, it is
recommended 1o integrate Google Workspace with Umbrella. During the deployment, the
Chromebook extension is added to the Google Admin Conscle. For more information, see
Umbrella’s Help.

Salt Value Required
To continue uging the DNS Security on Chromebooks, you must configure a Salt value and migrate
to DoH. For more information, see Umbrella's Help.

1. Deflne Salt

No value configured CONFIGURE
2. Chromebook Cllent Conflguration Flle

ChromebookConfig.json DOWNLOAD

3. Google Workspace Integration

It is recommended 1o sign in using a Google Super Admin account to sync Google

".'"JOF(SICECG dentities with Umbrella. \
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Google Setup

9. For the next step you will log into your Gsuite Admin Console at https://admin.google.com

= o Admin Q,  Search for users, groups or settings
I:;] Home

o M ~
OF Dashboard & Users anage

» 2 Directory
Add a user

» [0 Devices
Delete a user

b2t Apps
Update a user's name or email

» 'a Security
Create an alternate email address (email alias)

» 1l Reporting

Billing

Rules

8

» @ Account
@
()

Storage
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https://admin.google.com/

10. Navigate to Devices/Chrome/Settings/User & browser settings and select the OU you will be deploying the new
extension to (preferably the top level of the Domain).

m Home
EE Dashboard
y & Directory
~ [0 Devices
Qverview
= Chrome
Setup guide
Devices
Enroliment tokens

Managed browsers

Settings

Apps & extensions
Connectors
Printers

» Reports

» Mobile & endpoints

User & browser settings Device settings Managed guest session settings
< o T
—+ Ssearchor add a filter £9 Recent changes
General
Setting Configuration Inheritance Supported on
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11. In the “Search or add a filter” field enter “Manifest” then click the “Manifest V2 Extension Availability” setting.
Then select “Enable force-installed manifest V2 extensions” then click “Save.”

User & browser settings Device settings Managed guest session settings
< _
FulHtext: "manifest” & -+ Search or add a filter CLEAR FILTERS O Recent changes
Apps and extensions ()
Setting Configuration Inheritance Supported on
Manifest V2 extension availability Enable manifest V2 extensions Locally applied O
Manifest v2 extens will be deprecated in the future. All e 15 need to be migrated to
< ecifies if users can acce - exte - ome browser
More
Default browser behavior
. Disable manifest V2 extensions
Enable manifest V2 extensions
Configuration 1 | | Enable force-installed manifest V2 extensions

Cancel
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12. In the “Search or add a filter” field enter “DNS” then in the Network section click the “DNS-over-HTTPS” setting.
Select “Prefer DNS over HTTPS, allow insecure fallback” then click “Save.”

User & browser settings Device settings Managed guest session settings

Full-text: "DNS" @

E Serurity

Setting Configuration Inheritance Supported on

CLEAR FILTERS YO Recent changes

B Network

Setting Configuration Inheritance Supported on
WebRTC ICE candidate URLs for local IPs Google default a @

DNS over HTTPS 2 sub settings Locally applied jam} @ -
DNS-over-HTTPS with identifiers 2 sub settings Locally applied =

More ~

Inheritance Locally applied w
Configuration Disable DNS over HTTPS
1 Prefer DNS over HTTPS, allow insecure fallback

Require DNS over HTTPS

Use system default behavior

URI templates of desired DNS over HTTPS resolvers. One per line. If the URI template contains a {?dns} variable, requests to the resolver will use GET; otherwise
requests will use POST.

2.

D caneel
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13. In the “Search or add a filter” field enter “DNS” then click the “DNS-over-HTTPS with Identifiers” setting. Copy
and paste the Default DoH Template URL Link you saved in a Txt file earlier, then type the Salt Value you set
earlier, then click “Save.”

User & browser settings Device settings Managed guest session settings
Full-text: "DNS" <+ Search or add a filte CLEAR FILTERS Y0 Recent changes
G Kernrity
Setting Configuration Inheritance Supported on

a Network

Setting configuration Inheritance Supported on
WebRTC ICE candidate URLs for local IPs Google default =] @
DNS over HTTPS 2 sub settings Locally applied =] @ a8
DNS-over-HTTPS with identifiers 2 sub settings Locally applied =

You can specify URI templates for a DNS-over-HTTPS res: vith identity information and the salt value to be used

< | Thic nn

vecifving identif and it overrides the DNS-over-HTTPS pe £t o ant

More «

Inheritance Locally applied w

Configuration DNS-over-HTTPS terr

ates with identifiers
1. Paste Default | _roszeenumoreiocomcersy [

DoH Template

URI'templates of desired DNS-over-HTTPS resolvers which contain user or device identifiers. One per line. If the URI template contains a {?dns} variable, requests to the
resolver will use GET; otherwise requests will use POST. If both DNS-over-HTTPS templates and DNS-over-HTTPS templates with identifiers are set, Chrome0S will
default to DNS-over-HTTPS templates with identifiers

2 - E nter Salt Salt for hash ing Identifiers in the URI templates
value

AT USE TOT NASTITR] USET AT OEvICE TIETTITErS T INE TEmpiate URTS. UDTonar STartig CIromme Version 114,

3. Click Save

Cancel
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14. Navigate to Devices/Chrome/Apps & extensions.

O Admin

(8 Home >

EE Dashboard

» &2 Directory
~ [0 Devices
Overview
~ Chrome
Setup guide
Devices
Enroliment tokens
Managed browsers

Settings

Apps & extensions

Connectors
Printers
» Reports

» Mobile & endpoints
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15. Select Users & browsers.

Overview Users & browsers

Apps & Extensions

< Chrome Web Store
Allow all apps, admin manages blocklist

<+ Search or add a filter
Groups v
App Installation policy

Oraanizational Units A

Kiosks Managed guest sessions Requests

* ADDITIONAL SETTINGS

16. NOTE: For the next steps keep in mind that you will want to block/remove the old Cisco Umbrella Chromebook
clients while deploying the new Cisco Security for Chromebook app. So, ensure that the old Cisco clients are
removed from every OU that may have had them deployed. Each OU should look similar to this image when you

are finished with the deployment.

h=g

Pp

Cisco Security for Chromebook
& jonjacilojangagddnkeankieagghabk

Cisco Umbrella Chromebook client (App)
& cpnjigmgeapagmdimmoenaghmhilodfg

1_ r/ A \}'.@
J A

Cisco Umbrella Chromebook client (Ext)
P & jcdhmojfecjifmbdpchihbeilohgnbdci

Installation policy Version pinning

Force install

Block

Block

An additional note the new Cisco Security for Chromebook will need to be deployed to Gsuite Users NOT
Chromebooks. If you deploy to an OU that only contains Chromebooks, they will not receive the app. If the OU
contains both Users and Chromebooks, only the Users will receive the app.
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17. Block the old Cisco Umbrella Chromebook Clients in every OU they are deployed from:
In each OU the existing App and Ext are deployed in search for the following IDs set their installation policy to
Block.

Chrome App IDs to Block:
Cisco Umbrella Chromebook client (App) - cpnjigmgeapagmdimmoenaghmhilodfg
Cisco Umbrella Chromebook client (Ext) - jcdhmojfecjfmbdpchihbeilohgnbdci

REVERT SAVE

3. Click "SAVE"

Overview Users & browsers Kiosks Managed guest sessions Requests

< Chrome Web Store

S T S R Y
Allow all apps, admin manages blocklist 0 ADDITIONAL SETTINGS p) 2 x

Force install + pin to ChromeQS taskbar

Full-text: "cisco umbrella” -+ Search or add afilte CLEARFILTERS Force install

Allow install

App Installation policy Version pinning
2. Select the "Block" option

@ Cisco Umbrella Chromebaok client (App) Block
& cpnjigmgeapagmdimmoenaghmhiledfg Incognito mode

Cisco Umbrella Chromebool client (Ext) Block 1 - SeIeCt OId app

& jcdhmojfecjfmbdpchihbeilohgnbdci

Extension is mandatory for Incognito
Inherited from Google default
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18. Deploy the new Cisco Security for Chromebook app:
Select the OU you would like to deploy the new Cisco Security for Chromebook application to then hover over
the yellow plus icon in the lower right corner of the webpage and click the “Add Chrome app or extension by ID”
option.

® 0 B8O

Page 1 0of 1

19. Search by Chrome App ID and make sure that “From the Chrome Web Store” option is selected, then press
“SAVE.”

Chrome App ID: jgnjaoilojahgagddnkeankieagghabk

Add Chrome app or extension by ID

Chrome apps and extensions can also be added by specifying the ID. If it is outside the

Chrome Web Store, you must also specify the URL where the extension is hosted

Extension ID

jgnjaoilojahgagddnkeankieagghabk

From the Chrome Web Store *

CANCEL SAVE
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20. Select the newly added Cisco Security for Chromebook App, scroll down in the settings then copy/paste the
contents of the Json file you downloaded earlier. Then click “SAVE” in the top right of the webpage.

REVERT SAVE

3. Click "SAVE"

Overview Users & browsers Kiosks Managed guest sessions Requests

< Chrome Web Store

Allows all apps, admin manages blocklist ¢ ADDITIONAL SETTINGS Cisco Security for Chromebook m X

Use default permissions for this organization

Full-text: "cisco security" + searchor add afilter CLEARFILTERS
Blocked hosts
App Installation policy Version pinning
Cisco SECLITIW for Chromebook ‘ One per line. Maximum of 100 URLS.
@ o o Force install
® ignjaoilojahgagddnkeankieagghabk Allowed hosts
One per ling; allowed hosts override blocked hosts. Maximum of 100 URLs.
1. Select the new App Inherited from Google defaut
Policy for extensions
{"failClose"{"Value"false},'failOpenRetrylnterval™ .
{"Value":5}googleDirectoryService™ =
{"Value":false},'organizationinfo".{"Value":
2. Scroll down, | q
n
then paste Json
file contents
Locally applied +
+
Rows perpage: 10 = Page 1 0f1

21. Select the Cisco Security for Chromebook App again and change the Installation policy from Allow install to Force

install.
REVERT SAVE
H n n
3. Click "SAVE
Overview Users & browsers Kiosks Managed guest sessions Requests
< Chrome Web Store

£X ADDITIONAL SETTINGS e m X
Force install + pin to browser toolbar

FulHtext: "cisco security” =+ Search oradd a filte CLEARFILTERS 2 Change to “Force |nsta”“

Allow all apps, admin manages blacklist

Allow install
App Installation policy Version pinning
Block
Cisco Security for Chromebook .
@ o . . Force install
& janjaocilojahgagddnkeankieagghabk Incognito mode

Extension is mandatory for Incognito
Inherited from Google default

1. Select the new App

Chrome Web Store options

Include in Chrome Web Store Recommended
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Testing and Troubleshooting

22. Once deployed you can check on the sync status by going back to the Chromebook Users page in Umbrella
Dashboard and search for the user’s identity or the device’s serial number. Or you can sort by the “Last Sync”
column.

Note it may take a few minutes before users start showing up as synced.

Cisco Umbrella

Core ldentities

Networks

Network Devices

Roaming Computers

Mabile Devices

Chromebook Users

Users and Groups

i A
© information  Chromebook Users e

A Chromebook User identity represents the integration of a Chromebook device with Umbrella. To integrate Umbrelia with a Chromebook device, deploy the Cisco Security for Chromebook client. Once deployed, this client lists y
Chromebook users as Umbrella identities that can be added to the DNS and Web policies. To get started, click Configure. For more information, see Umbrella’s Help.

Q Advanced v/

1306 Total

Last Sym:l : |<._

ChromeOS [Version 123.0.0.0] 7 minutes ago

‘ChromeOS [Version 123.0.0.0] 12 minutes ago
ChromeOS [Version 123.0.0.0] 13 minutes ago
ChromeOS [Version 124.0.0.0] 14 minutes ago
ChromeOS [Version 123.0.0.0] 14 minutes ago
ChromeOS [Version 120.0.0.0] 14 minutes ago

83|Page



23. You can also check if the App has successfully deployed to a Chromebook by checking the logged in users
Extensions as well as visiting https://policy-debug.checkumbrella.com while logged in as the user.

. X
Extensions
No access needed
These extensions don't need to see and change
information on this site.
& Application Launcher For Drive... n : b value |
@ Cisco Security for Chromebook n :

2 Manage extensions

o dente By Ohaibe B

* C B gyt e treta e

bl : '
cisco | Jmbrella

dactad Senheall

J You are p by Cisco L DNS!

Tha o & Oesgrated teal 500 19 aanly 1ad ahuch pobiCy you e Comently Dy Eowersed
ty

Beiom 18 5 (h 20 Thy M Puru s K Tve wterret wecurfty by

)

! you 2w ot e Neteork Adersnairator, pheane Mnd 3 Cogy of 1he s0owe hok 1 your

Netarrs Aomasstrator

Garwral

oy
Bote O
gm0

Apply Policies

To apply your policies to your organization's Chromebooks, see the Cisco Umbrella Chromebook Client Policy Configuration
Guide.
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https://deployment-umbrella.readme.io/v1.0.5/docs/configuring-policies

Make sure you have deployed the Cisco Umbrella Chromebook client before you configure policies. For more information, see

the Cisco Umbrella Chromebook Client Deployment Guide.

For general information about configuring policies in Cisco Umbrella, see Create and Apply Policies.

Overview
The overall process is to create a Chromebook-specific policy that will work together with your "network usage" policy that
applies to all devices connected to your networks. You place the Chromebook policy at the top of your policies list, so it will be
invoked first. This ensures that the Chromebook policy is applied to your Chromebooks. Then your network policy comes into

effect for all other devices connected to your network.

To maintain end-user privacy when Chromebooks are connected at remote locations, you can also disable Content Logging

and include only security-related events in your reporting.

Create a Chromebook-specific policy

Follow these steps to create a policy to apply to all Chromebook users when connected to your network as well as outside of

your networks.

1. Navigate to Policies > Management > All Policies and click Add.
The Policy Wizard opens.

alvaln, MRnaemast ] o
© “di& Al Policies o

Sorted by Order of Enforcement

w

Defautt Pollcy All Identities 3 Policy Settings ~ Mov 1, 2017

2. Select Chromebooks (some or all). Do not select any networks.

What would you like to protect?

Select Identities

Search |dentities

« AD Computers
a»  Networks
L1 Roaming Computers

@ Sites

Expand to select specific

Network Devices Chromebook users

] Mobile Devices

& Chromebook User

‘& GSuite Users

All Identities

85|Page


https://docs.umbrella.com/deployment-umbrella/docs/cisco-umbrella-chromebook-client-deployment-guide
https://docs.umbrella.com/deployment-umbrella/docs/customize-your-policies-1
https://files.readme.io/fe29525-click_add.png
https://files.readme.io/0ba3d87-select_chromebook_users.png

3. Click Next.

Choose the content settings and security settings to apply to Chromebooks. A common practice is to enable
the default security settings and disable content filtering to maintain user privacy.

4. Expand Advanced Settings and turn off Enable Intelligent Proxy.
The Intelligent Proxy is not supported at this time.
Optionally, you can choose to log only Security Events to protect users' privacy.

Apply Destination Lists

ADVANCED SETTINGS

Enable Intelligent Proxy ]

SSL Decryption
Turning on SSL decryption allows HTTPS URL blocking

Enable IP-Layer Enforcement

0O Enforce SafeSearch
= for af rch f Learn More

Allow-Only Mode

@ Log All Requests

O  Log Only Security Events

() Don't Log Any Requests

Click Next. Generally no changes are needed to the Security Settings.
Click Next. Similarly, Content Access settings often remain the same.
Click Next. Make any needed changes to the Application Settings.
Click Next. Make any needed changes to Destination Lists.

Click Next.

The Custom block page, Bypass Users, and Bypass Codes features on this page are not yet supported by the
Chromebook client.

W oNow

Set Block Page Settings

Define the appearance and | s options for your block pages.

(® Use Umbrella's Default Appearance
Preview Block Page »

() Use aCustom Appearance

Choose an existing appearance -

Currently unsupported

BYPASS USERS
BYPASS CODES
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9. Click Next. Give your policy a name (the name is arbitrary), then click Save.

Policy Summary

Policy Name

’ Chromebook Policy|

U 10 Identities Affected ‘J 2 Destination Lists Enforced
10 Chromebook Users = 1 Block List
Edit = 1 Allow List
Edit
U Security Setting Applied: Default Settings
« Command and Control Callbacks, Malware, and Phishing U File Inspection Not Enabled
Attacks will be blocked Requires Intelligent Proxy
= No integration is enabled.
Edit  Disable

U Umbrella Default Block Page Applied
Edit  Preview Block Page
.J Content Setting Applied: High
= Blocks adult-related sites, illegal activity, social networking
sites, video sharing sites, and general time-wasters.
Edit  Disable

ADVANCED SETTINGS

CANCEL PREVIOUS

Your policy is automatically applied to Chromebooks. The process takes up to about 90 seconds.
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Arrange policies in order

Policies in Cisco Umbrella are applied in sequence from the top of the Policy List down. Make sure that your Chromebook
policy appears above your network usage policy. This ensures that your Chromebooks are protected by your Chromebook-

specific policy and all devices on your network (that are not Chromebooks) are protected by your Network Access policy.

@ Sorted by Order of Enforcement
. Applied To Contains Last Modified A
Chromebook Policy 10 Identities 3 Policy Settings ~ Aug 28, 2018
. Applied To Contains Last Modified A
Network Accass Policy 0 Identities 3 Policy Settings ~ Aug 28, 2018

Trusted Network Detection

The version of the Cisco Umbrella Chromebook client (UCC) released November 28, 2018 introduced trusted network
detection. Trusted network detection enables UCC to work with Umbrella virtual appliances (VAs) so that in a situation in
which a network can be trusted by the UCC because it is protected by Umbrella VAs (for example, in an on-premise network),

a Chromebook-specific policy can take precedence over the existing network policy.

How trusted network detection works

When the UCC detects a VA in a network, it sends the Chromebook user's identity to the VA and then deactivates. The VA

continues to handle DNS requests from Chromebooks by appending the users' identities to all requests to Umbrella resolvers.

When the UCC fails to detect a VA, the UCC directly sends DNS requests to Umbrella resolvers.

This update is reflected in the following architecture diagrams. First is the original UCC architecture.

INSIDE CHROMEBOOK
1& @ EE$ ——/
)
Chrome Browser Chrome Chrome App Umbrella
Extension Local DNS Server Resolver
Auto register device
Auto register device

Get Policies

Q .

Apply Policies |
@ View Reports /\/

Manage Devices —

Umbrella Dashboard

The November 28 release means the UCC system is better represented this way.
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Internal Netwark INSIDE CHROMEBOOK

80—

User Chrame Browser Chrome Chrome App
[Teacher/Student) Extension Local DNS Server

4
VA Post Identity
- =

Public Queries

Auto register device

e
0 /)

Umbrella
Resolver

I

Get Policies

( Apply Policies —
View Reports | /

Admin Manage Devices

Umbrella Dashboard

Important

In order to enable trusted network protection, both the Umbrella Chromebook client software and the Umbrella virtual

appliance software must be updated.

Software requirements

In order to enable trusted network detection, the following minimum software versions are required:

Umbrella Chromebook client extension 1.2.0
Umbrella Chromebook client app 1.2.5
Umbrella virtual appliance 2.3.2
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Removing Cisco Chromebook client software

To remove the software for a specific user:

1. Loginto your G Suite admin console, then click Users.

= Google Admin Q, Search for users, grg

Admin console

g= ®
=il Fiacy
Dashboard Users
See relevant insights Add, rename, and
about your domain manage users

2. Choose a user, then choose More > Change Organizational Unit.

All organizations £ 1 user selected X
+

@ Users from all organizational units N + Add a filter

O Users from selected organizational units
Name 4

Alexander TSEDemo

3. Click Change* to confirm your choice.
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https://files.readme.io/3d117d5-Google_admin_users.png
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User move confirmation

Alexander TSEDemo

Please review the following that applies to the DemoOrg

organization
22 Some services may not be turned ON

The users will not be able to use the services that are not

turned ON

== Some service level settings may change for the selected

A

users

Are you sure you want to move Alexander to DemoOrg?

0 This change may take up to 24 hours to take effect.

CANCEL J CHANGE

You have finished removing the Chromebook client for that user.

To remove the software for all members of an Organizational Unit (OU):
1. Follow the instructions for Installing the Cisco Umbrella Chromebook client extension.

2. Select the OU you wish to remove the extention from, then select Cisco Umbrella Chromebook client (Ext)
3. Click the trash icon to remove the extension, then click SAVE

REVERT SAVE |§

ps & extensions WHAT'S NEW

USERS & BROWSERS KIOSKS MANAGED GUEST SESSIONS

<
Cisco Umbrella Chromebook
' Search or add a filter X
+ 1 Id a filter client (Ext) E 3|

App Installation policy Chrome Web Store options

eb Store collection
Allow other apps & extensions from the C
Allow users fo install other apps & extensions
Inherited from Google default

@ Cisco Umbrella Chromebook client (App) ~ Force install Permissions and URL access

& cpnjigmgeapagmdimmoenaghmhilodfg Locally added
Use default permissions for this organization

@ Cisco Umbrella Chromebook client (Ext) ~ Force install
& jcdhmojfecifmbdpchinbeilehgnbdci Locally added Blocked hosts
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Cisco Secure Client (Roaming Client Replacement)
Migration

Reference: https://support.umbrella.com/hc/en-us/articles/17890678933012-How-do-I-install-Cisco-Secure-Client-with-
the-Umbrella-Module

NOTE: The old Cisco Umbrella Roaming Client will no longer be supported after April 2, 2025, please ensure you are fully
migrated over to the new Cisco Secure Client before Aprile 2, 2025.

Also note that if you are running an existing version of the Roaming Client then the Cisco Secure Client installer will
uninstall the Roaming Client and import it’s settings.

Download the Cisco Secure Client from the following location in your Cisco Umbrella Dashboard

Cisco Umbrella Deployments / Cors Identtisa

t ara protscted by sither the Umbralla Roaming Clisn, or Cisoo Securs Client Umbralla module {formerly AnyConnect). This sres of the Deshbosrd gives sdministrstors the gty to deploy your clisnta
tight and 1o mensgs your Rosming Computsrs below.

Step 1. Download the latest version of Cisco Secure Client
Select the Pre-Deployment Package: Windows (x86/x64)
Step 2. Download the Umbrella Roaming Security Module Profile

Important! Make sure to keep the default name Orglnfo.json
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Download Cisco Secure Client X

Cisco Secure Client (Recommended)
Step 1. Download the latest version of Cisco Secure Client

Pre-Deploymsant Package:

Note: Earlisr versions of Cisco Seeurs Clisnt can be downloaded st Softwars

Step 2. Download the Umbrella Roaming Security Module Profile

After the files have downloaded, make sure they are both saved in a known location.

Extract the .zip file

Mame

o cisco-secure-client-win-3.1.2.42-predeploy-k3.zip
«| Orglnfojson

After the files are extracted, only keep the umbrella-predeploy-k9.msi file AND the Profiles/umbrella Folder
Copy the Orglnfo.json file you downloaded into the Profiles/umbrella Folder

o~

Mame

Profiles

"W cisco-secure-client-win-5.1.2.42-umbrella-predeploy-kS.msi

Determine which installation options you will need:
Basic Setup - No Restart

msiexec.exe /package cisco-secure-client-win-5.1.2.42-umbrella-predeploy-k9.msi /norestart /passive

Setup - Hide From Programs
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msiexec.exe /package cisco-secure-client-win-5.1.2.42-umbrella-predeploy-k9.msi /passive ARPSYSTEMCOMPONENT=1
/norestart

Setup - Lockdown Service

msiexec.exe /package cisco-secure-client-win-5.1.2.42-umbrella-predeploy-k9.msi /passive LOCKDOWN=1 /norestart

Setup - Hide From Programs and Lockdown Service

msiexec.exe /package cisco-secure-client-win-5.1.2.42-umbrella-predeploy-k9.msi /passive ARPSYSTEMCOMPONENT=1
LOCKDOWN-=1 /norestart

i0S Mobile Security- iPads in Umbrella

The Cisco Security Connector—Umbrella Setup Guide only explains how to configure the Umbrella portion of the Cisco Security
Connector (CSC). For information about how to configure your Mobile Device Manager (MDM) system, see your MDM
system’s documentation.

The Cisco Security Connector provides visibility and control for organization-owned and MDM managed mobile Apple iOS
devices, such as iPhones and iPads. The CSC's Umbrella component directs DNS traffic, including functionality for the
intelligent proxy, to the Cisco Umbrella cloud where filtering against malicious sites, such as phishing sites or sites that

exfiltrate information, takes place.

The CSC’s Umbrella portion does not require an on-demand or always-on VPN or a full proxy to gain complete visibility and
control through cloud security (not locally on the device). This makes for both easier management and simpler, more effective

security.
Note: Your iOS mobile device must be supervised and managed by an MDM system.

For more information about the Cisco Security Connector, see Cisco Security Connector (CSC).

Requirements

For the Cisco Security Connector:

e iOS device running iOS version 13.2 or higher.
e YouriOS device must be running in supervised mode.

e Your iOS device must be managed using a Mobile Device Manager (MDM) system and Apple School Manager or Apple

Business Manager.
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Five MB free space.

One of the following supported MDM systems:

Meraki System Manager (SM) with API access enabled.

Note: Only System Manager and Combined network types are supported.

Apple Configurator 2.5 or higher.

IBM MaaS360.

Intune.

Jamf.

MobiConnect

Mobilelron Enterprise Mobility Management (EMM) On-Prem and Cloud versions 9.4 or higher.
Workspace ONE.

Generic— MOSYLE - Other MDMs may be used to manage your organization-owned iOS mobile device; however, success

results may vary. For more information, see Register an iOS Device through a Generic MDM System.

For information about configuring your specific MDM system, see your MDM system’s documentation or contact your MDM's

support team.

You will also need:

Cisco Umbrella account.

Direct access to the IPv4 IP addresses 208.67.222.222 or 208.67.220.220 is required for IPv4 DNS protection on ports 53
and 443.

Direct access to the IPv6 IP addresses 2620:119:35::35 or 2620:119:53::53, or access to IPv4 addresses on ports 53 and 443
through NAT64/DNS64 translation is required for IPv6 DNS protection.

Note: If DNS protection fails to engage, DNS traffic is not encrypted.

The device must be able to communicate with registration.polaris.qq.opendns.com for registration and validation

purposes at least once a day—when actively used—otherwise, the device cannot be protected.

Depending on the MDM, you may also require each device's serial number.
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1. Install the Cisco Security Connector App

1. Onyour iOS device, download and install the Cisco Security Connector app.
Get the Cisco Security Connector app from the App store. Depending on your MDM, you may be able to deploy the Cisco

Security Connector to supervised iOS mobile devices through your MDM.

Cisco Security Connector

Y

Protection anywhere,
anytime

Providing deeper visibilty and control for

enterprise-owned davices

Leam More

2. Add an Organization Administrator’s Email Address

This is the email address that your end-user can use to send diagnostic reports from the app by clicking the I icon from within
the iOS device. These reports can then be passed onto Cisco support. Once set, this email address is automatically added

when managing an MDM.

1. Navigate to Deployments > Core Identities > Mobile Devices and click Settings.

Deployments / Core Identities A
vifrar]n ; 5 @0/
cisco MOb”e DeVICeS Settings Manage MDMs
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2. In Mobile Device Settings, add an email address, select a notifications level, choose a device identification method, and

click Save.

Mobile Device Settings

Organization Administrator’s Email Address
This email is for end users to generate problem reports within the Cisco Security
Connector app and send these reports to the administrator,

email@admin.com

User Notifications
Adjust level of notifications shown to users on their device

© None
Notify on Protection Failure
Notify on Protection Change

Device Identification
Choose whether to display device name or anonymize with serial number only,

Full Identification v

[eaen | 1N

3. Register Your iOS Device Through Your MDM to Umbrella

1. In Umbrella, navigate to Deployments > Core Identities > Mobile Devices and click Manage MDM:s.

yments [ Core Identities >
vl Deployments / Core Identities ({&\‘ |/@0\|
o N

Settings Manage MDMs

’ casco Mobile Devices

2. Click the appropriate MDM.
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Manage MDMs
Add or manage devices using the MDM of your choice.

. Cisco Meraki
seo M

" Link MOM

’

Apple
' Download MobileConfig

1BM Maas360
1BM MaaS360 ==
Download MobileConfig

Microsoft Intune
2% Microsoft
Download MobileConfig

2 jamf ot

Download MobileConfig

MobiConnect
[ mobiconect
Download MobileConfig

Mobilelron
@) Mobilelron
Download MobileConfig

i;’ Workspace ONE

Download MobileConfig

Don’t see your MDM?
You can download our generic mobileconfig file and link the MDM manually.

4. When you have successfully registered your iOS device, Umbrella lists it at Deployments > Core Identities > Manage

MDMs.
Deployments / Core Icentities
), . A
CI5E9 MOblIe DeVICeS Settings Manage MDMs
Label Serial Number Last Sync OS Version App Version Mdm
WJC C8PWW3JWJICE 2018 i0S 11.2 0.0.0 e

5. Onyour mobile device, in the Cisco Security Connector app, tap the Status icon and confirm that it shows Protected by

Umbrella. For protection details, tap Protected by Umbrella.
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£ Status Umbrella

ROAMING SECURITY PROTECTION STATUS
v Protected by Umbrella IPv4 Status Protected
IPv6 Status Protected

ENDPOINT VISIBILITY

@ Clarity Not Configured DIAGNOSTICS

Generate Diagnostics
Generate additional diagnostics for problem reports

DETAILS
Org ID 682
Device ID OADOFO
Device Label Eris (VITG6HG6X)
Notifications On Change
WiFi SSID
WiFi BSSID

8 hod s b

Jamf

By downloading an XML file from Umbrella, optionally updating it, and then pasting part of its contents into your Jamf system,
Jamf is able to push configuration information to both the Cisco Security Connector (CSC) and Umbrella so that your iOS

device is registered with Umbrella. The result is that your iOS device is protected by Umbrella.

For information about configuring Jamf, see Jamf's documentation.
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Anonymization

Umbrella provides you with the option of anonymizing mobile devices for reporting and administration purposes. When you
anonymize a mobile device, its label is hidden and replaced by your device's serial number. The label name is anonymized in
both the Umbrella dashboard and in the CSC app Ul. For information about how to anonymize your device, see Anonymize

Devices.

Prerequisites

e Jamf Pro 10.2.0 or higher.

e You must first configure your Jamf MDM system. Configure Jamf as required so that it is able to push configuration
information to both CSC and Umbrella. For information about configuring Jamf, see Jamf documentation. For support,

contact Jamf support.
e The Cisco Security Connector app is installed on your iOS device.
e iOS device running iOS version 13.2 or higher.

e YouriOS device must be running in supervised mode.

e YouriOS device must be managed by Jamf and Apple School Manager or Apple Business Manager.

e You have added an administrator email address.

This address is used by CSC to send you diagnostic reports that you can pass on to Cisco support as needed.
e You'll need the serial number for each iOS device to be registered with Umbrella.
e Cisco Umbrella account.

e Direct access to the IPv4 IP addresses 208.67.222.222 or 208.67.220.220 is required for IPv4 DNS protection on ports 53
and 443.

e Direct access to the IPv6 IP addresses 2620:119:35::35 or 2620:119:53::53, or access to IPv4 addresses on ports 53 and 443
through NAT64/DNS64 translation is required for IPv6 DNS protection.

Note: If DNS protection fails to engage, DNS traffic is not encrypted.

e If anonymizing devices, Mobile Device Settings are updated to By Serial Number Only. For more information

see, Anonymize Devices.

e YouriOS device must be able to communicate with .opendns.com for registration and validation purposes at least once a

day.
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Regqgister Your iOS Device

Note: You must log into your Umbrella dashboard as an administrator.

1. InUmbrella, navigate to Deployments > Core Identities > Mobile Devices and click Manage MDM:s.

el Doolo;\-'rro‘ms | Core lco?t|t|os l/{&\‘ |’/@_0\‘|
- asco Mobile Devices o . o

2. Under Jamf, click Download MobileConfig.

Manage MDMs
Add or manage deices l.|$i|'|g Ehe MIDM o Woaar Choeis,

Cisco Meraki
-:lli.Llu.
Link MDM
[
Apple
. Download MobileConfig
IEM Maas 360

IBM aaS350 2=
Download MobileConfig

Microsoft Intuna

BY Microsoft
Download MobileConlig

A jamf o

Download MobileConfig

™S

3. Add an email address to generate problem reports and click Download.
This email address is where diagnostic reports are sent when a user clicks the I icon from within the iOS device. Once set,

this email address is automatically added when managing an MDM.
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Download Jamf Mobileconfig

Organization Administrator’s Email Address

admin@example.com

4. Copy and paste the XML code between the <!-- Jamf... --> comments into your MDM profile.

XML

<?xml version="1.0" encoding="UTF-8"7>

<IDOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-
1.0.dtd">

<plist version="1.0">

<dict>
<key>PayloadContent</key>
<array>
<!-- Jamf - copy from here to paste into the Jamf UI to provision a DNS proxy -->
<dict>
</dict>
<!-- Jamf - end copy -->

5. Inyour new profile, applied for the CSC group, choose Custom Settings and then Configure. Paste the edited XML here.
If successful, your mobile device registers with Umbrella and is listed at Deployments > Core Identities > Sylvia Massy. CSC

on your mobile device updates to connect to Umbrella so that your iOS device is protected by Umbrella.

6. Example of what is put into the Config Profile in Jamf from the downloaded jamf.xml file obtained from Umbrella: (your

organization id string and regToken will be different)
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<?xml version="1.0" encoding="UTF-8"7>
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/
PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>PayloadContent</key>
<array>
<dict>
<key>AppBundleldentifier</key>
<string>com,cisco.ciscosecurity,app</string>
<key>PayloadDescription</key>
<string>Cisco Umbrella</string>
<key>PayloadDisplayName</key>
<string>Cisco Umbrella</string>
<key>PayloadIdentifier</key>

<string>com,apple.dnsProxy.managed. DBE2A157-E134-3E8C-B4FB-23EDF48A0CD 1</

<key>PayloadType</key>
<string>com.apple.dnsProxy.managed</string>
<key>PayloadUUID</key>
<string>E5D191FD-6E01-4733-9720~E27BFBCBBDC5</string>
<key>PayloadVersion</key>
<integer>l</integer>
<key>ProviderBundleIdentifier</key>
<string>gcom.cisco.ciscosecurity.app.CiscoUmbrella</string>
<key>ProviderConfiguration</key>

<!== Jamf - copy from here to paste into the Jamf UI to provision a DNS proxy -->
<dict>

<key>anonymizationtevel</key>
<integer>@</integer>
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New Mobile Device Configuration Profile

Options Scope
1Emor

Er}' Single App Mode

Mok Co

& Global HTTP Proxy
W o configured

,._‘.1

@
3
g

Mat €

f

Mot Condi

ga AlrPrint
= ot Configured

@ Content I| ter
Mot Cenfig i

reen Massage

n Lock
Mat Cx

DNS Proxy

APP BUNMDLE ID Bun o DNS |

cem.cisco.ciscosecurilyapp

PROVIDER BUNDLE ID  Bundle identifier of the preferred DMS Proey extension

PROVIDER CONFIGURATION XML Vender specific configuration values

<dict>
<key=ananymizationlevel<key>
<integer=0<finteger>
<keyrdisabled<key
<falsel=
<ksy=intarnalDomains</key>
“array=

<string=10.i

acld .rpa-:.'sning:w

1 lpa< 5tr||1g'>
ATpas/string>
rarpa</string=
ddr,arpasistring>
rarpa=/string=

Inarpas/string=
rarpaisting>

<string>2 L7 2.in-addr. arpaf."strmga
<string=2 rpa=/string=
<string=2
“string=3

<keyrloglevel=/key=>

<string=verkose</string=
<keyrorgAdminAddress<ikey=
“string=damien.steele@maynard k12.arus</string=
<key=organizationld=/lkey=
<string=2304376</string>

“keyrregTokens/key>

<kay>serialNumbearkey>
<string=$SERIALNUMBER</string=>
</dict>

Uplaad Provider Configuration XML



Mosyle

1. Download the Cisco Security Connector from the Apple Volume Purchase Program

Volume Purchase Program 50.00
Search Media Type Category
(Q cisco umbrella i0S Apps v| |[All v Search

Purchase Details

I Price Quantity
(J Cisco Security Connector Free iOS App
by Cisco
20
Managed Distribution: Free apps are only available in bulk using managed distribution. Assign apps by using a Mobile Device Management (MDM) solution,
such as the latest version of Apple Profile Manager. You retain ownership of apps only, allowing you to revoke and reassign them as needed. Learn More »

2. Push out the Cisco Security Connector App with Mosyle.
3. Download the Generic Mobileconfig file.

Example:

4. In Mosyle, navigate to DNS Proxy Extension and enter the following:
e Name — Cisco Umbrella
e App Bundle Id — com.cisco.ciscosecurity.app
e Provider Bundle ID - com.cisco.ciscosecurity.app.CiscoUmbrella

e Provider Configuration — everything in the generic mobile config file.xml from
<dict>
<key>anonymizationLevel</key>
<integer>0</integer>
<key>disabled</key>
<false/>

<key>serialNumber</key>
<string>{SERIAL_NUMBER}</string>
</dict>

e Replace SERIAL_NUMBER with %SERIALNUMBER%
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AirPrint
Allowed/Blocked Apps
App Lock
Autonomous Single App Mode
Calendar Q
Certificate Transparency
Cisco Umbrella
Cellular
Cellular APN
Certificates / Custom Profiles
Contacts
DNS Settings
Domains

Exchange

DNS Proxy Extension

+ Add new profile Profile Name *

Cisco Umbrella
Y All Location(s)

App Bundle ID *

Provider Bundle ID

<dict>

53]

Provider Configuration View available variat

com.cisco.mscosecurlty.app

com.cisco.ciscosecurity.app.CiscoUmbrella

er>0</int

Dashboard

AirPrint
Allowed/Blocked Apps
App Lock
Autonomous Single App Mode
Calendar Q
Certificate Transparency
Cisco Umbrella
Cellular
Cellular APN
Certificates / Custom Profiles
Contacts
DNS Proxy Extension
DNS Settings

Domains

My School Management Class Manager

+ Add new profile

Y All Location(s)

5. Assign it to the students/staff/devices you want and push out those settings in Mosyle.
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If you have anonymized your device (see Anonymize Devices), Umbrella hides the device's true label name by replacing it with

the device's serial number. Existing active devices anonymize with 24 hours. New devices anonymize immediately.

Deployments / Core Identities (o) 2\
alaln, _)C.Jluy’r‘c.n[_. re CC. tie ',‘{:I',,' "‘00,_"
Cisco MOb||e DeV|CeS Setr.—mgs Managé MDMs
Label Serial Number Last Sync OS Version App Version Mdm
C8PVV3JWJC6 C8PVV3JWJC6 2018 i0s11.2 0.0.0 =S

As no changes can be made in Umbrella to the actual provisioned device, these mobile devices are simply listed in Umbrella as
identities; however, you can now use Umbrella to apply policies to these mobile device identities. For more information,

see Apply Umbrella Policies.

Android Mobile Security

Umbrella has just recently released feature. If you would like to try it, please see the latest documentation here.

Adding an additional Fixed/Static Network
(MiFi/Jetpack)

Step 1 — Obtain a static IP/range from your ISP

First, determine the IP address of your network.
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2. In Umbrella, navigate to Deployments > Core Identities > Networks.

You'll find your IP address listed at the top of the page. If you don't see your IP address, click the i (Information) icon.

ool Deployments / Core |gentities

casco  Networks e

Add

A network may be a single public IP address (static or dynamic) or a range of public IP addresses, depending on the size of your
network. Add a network to Umbrella to extend protection to any device that connects to the internet from behind that network's IP
—xxx.xx

space. The public IP of your network is|XXX.XX.

Pre-registering Your Networks

If you plan to have multiple network identities, it's a good idea to immediately register all of your networks with Umbrella.

Chances are that if you have more than one public egress IP in your organization, you'll have more than one network identity.

Having the networks pre-registered ensures that they're available right away when you do point traffic. It also ensures that all

the IP space that belongs to your company is correctly assigned in our systems. Until traffic is pointed to Umbrella's DNS

service, no protection is available and there is no reporting so there's no harm in adding all networks beforehand.

Step 2 — Set up the Network Identity

.Navigate to Deployments > Core Identities > Networks and click Add.

Cisco Umbrella

einformation N etwc ks @

/'

N
@)

Add

e ‘ Q, Search with a network name or IP address

Advanced ‘

Networks

. Name & IP Address
Network Devices
Roaming Computers DIS-Public

Dynamic Primary Policy Status

@ Active

Note: If possible, add the network from the IP being registered; otherwise, an email is generated, which requires that a link is

visited from the IP address of the network being registered.

2. Inthe Add a New Network modal, give your network identity a meaningful Network Name.

Giving your identity a good network name will help you find it easily when you later add a policy against it through

the Policy wizard.
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Add a new network

Start by pointing your network's DNS to our servers:

IPv4: 208.67.220.220 and 208.67.222.222
IPv6: 2620:119:35::35 and 2620:119:53::53

Network Name

@ IPv4 only O IPv6 only O Mixed IPv4 & IPv6
IPv4 Address

0.0.0.0 / |32 v

() This network has a dynamic IP address. Leam More »

—

3. Select an internet protocol—IPv4, IPv6, or both.

Select a protocol based on the Umbrella IP address to which you have configured your router.

4. Add the network's IP address along with the subnet mask, usually a /32 subnet for IPv4 and /64 subnet for IPv6.

5. Click Save.
Once the service validates your IP address, the network is listed at Deployments > Core Identities > Networks. Initially,
Umbrella lists your new network identity's status as Inactive. Network status only changes to Active when DNS traffic is
sent to Umbrella from the network.
The policy applied to your new identity depends on your policy configurations. If you have a policy configured that includes

network identities, Umbrella applies that policy; otherwise; Umbrella applies the Default policy.

Name B IP Address Dynamic Primary Policy Status
Network Identity One 12.12.12.2 Default Policy Inactive
Name : IP Address Dynamic Primary Policy Status
Network Identity One 12.12.12.2 Default Policy & Active
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Step 3 — Change the DNS Settings on Your Relevant Network Device

You need only do this on your edge DNS equipment, typically a DNS or DHCP server, or a router—this could be your DSL router

or cable modem if that's the only router in your network. Change DNS to 208.67.222.222 and 208.67.220.220

Example for Verizon Orbic Hotspot:
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RSD VZ Hotspot Orbic &

Hame RSD V7 Hotspot Orbic S0V Export Cancel Delete

Fialds marked with an asterisk® are optional I left empty or selection is “Mot Managed”, the existing value on the device will be used.

Wi-Fi >

Security ¥
Advanced v

Mac Filber

MAC Filter Enabled Mo W

Add User's Device's Wi-Fi MAC Addresses.

Add WiHFI MAC Addresses for Matching User Property

White Listed MAC Address

Blocked MAC Address
Manual DMNS Enabled s w
Manual DMNS Address 1 208 6T 222232
Manual DMNS Address 2 208 67 220220
RFC1918 Privale IP Address Ranges Dizabled W

wm.ﬁs Range Included /

Login to Umbrella with the laptop or device that is connected to the MiFi you are setting up and click on Verify from that
device:
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2, Search with a network name or IP address ~ Advanced

Name & IP Addrass Dynamic Primary Policy Status

DIS-Public Default Policy & Active

VZ-MiFi-63.46.50.221 Default Policy

Step 4 — Test Your Network after it’s verified and active

Verify that your DNS connections are routed through Cisco Umbrella's global network by navigating to the following page in
your client's browser: https://welcome.umbrella.com/. You should see the Welcome to Umbrella page.

Note: You may need to restart your client's network interface or your computer.

To test your security settings, navigate to http://examplemalwaredomain.com/.

Support  ContactUs  Login

asco. CiSCO Umbrella Product Customers Use Cases Partners Resources Blog Q

Q Welcome to Umbrellal

Your internet is faster, more reliable and better
protected because you’re using Cisco Umbrella.
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Appendex:

Application Category Descriptions

e Ad Publishing—Applications that enable publishers and ad networks to manage ad serving and trafficking.
e Anonymizer—Services that provide an anonymous proxy tool that attempts to make activity on the Internet untraceable.

e Application Development and Testing—Applications suited for application development and testing cycles, or for building

integration applications in the cloud and within the enterprise.

e Backup and Recovery—Applications for backup and recovery of file systems and raw data stores on servers and desktop

systems.

e Business Intelligence—Applications for analytics such as dashboards, reporting systems, scenario modeling, and data

analysis.

e Cloud Broker—Applications that manage the use, performance, and delivery of cloud services and negotiate relationships

between cloud providers and cloud consumers.

e Cloud Carrier—Intermediary that provides connectivity and transport of cloud services between cloud consumers and

cloud providers through a network, telecommunication, and other access devices.

e Cloud Service Provider—Based on NIST definition of a cloud service, which we believe is being (slowly) adopted as the
industry standard. The NIST definition includes the following criteria: "on-demand self-service, rapid elasticity, and
measured service. CAS| additionally adds vendor intent to provide computing-related services (Compute, Network, Storage
and/or Software Application). If in doubt whether web or cloud, we will be conservative and assume cloud until we can

prove otherwise.

e Cloud Storage—Applications that offer massively scalable storage capacity that can be used for applications, and file

storage.

e Collaboration—Applications that enhance communication and collaboration in workgroups, within enterprises, and across

enterprises.

e Compute—Fundamental computing resources for running cloud-based systems that can be dynamically provisioned and

configured as needed.

e Content Delivery Network (CDN)—Applications that store content and files to improve the performance and cost of
delivering content for web-based systems by offering a large distributed system of servers deployed in multiple data

centers across the Internet.
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e Content Management—Applications for managing the production of and access to content, enforcing document

production workflows, and providing workspaces for groups or enterprises to find and access documents.

e Customer Relationship Management (CRM)—Applications that manage interactions with current and future customers,

including organization and automation across sales, marketing, and customer service functions.

e Database Management—Applications offering scalable data management solutions for structured or unstructured data,

relational database solutions or scalable non-SQL datastores.
e E-Commerce—Applications that facilitate the buying and selling of products or services.

e Education—Applications that provide educational or training courses, general learning opportunities or specific employee

training independent of their location.

e Enterprise Resource Planning (ERP)—Applications that manage operations or management of a business; which can

include internal and external resources, including tangible assets, financial resources, materials, and human resources.
e Financial Services—Applications for managing financial processes and information.
e Games—Online and mobile games.
e Healthcare—Healthcare related apps and services.

e Hosting Services—Applications that enable corporate or individual websites or other content to be accessible over the

internet.
e Human Resources—Applications for managing human resources and HR functions.
e IT Service Management—Applications that support specific IT functions to plan, deliver, operate and control IT services.
e Legal—Applications that provide access to legal documents and public records and support legal content.
e Marketing & Sales—Applications that are specifically designed for marketing and sales functions.
e Media—Applications that host or stream media as a service.

e Office Productivity—Applications for producing information and other standard office-oriented tasks such as

documentation, presentations, project management, etc.
e Others—Used for those services where no existing categorization would fit.
e P2P—Peer to Peer torrents like apps and protocols.

e Search—Web or app-based search.
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e Security—Applications that support security activities to ensure adherence to regulatory compliance rules and protect

information, data applications, and infrastructure.
e Service Management—Applications that support general operational activities outside of the IT function.
e Shopping—Web or app-based basic online shopping.

e Social Networking—Applications that establish and maintain a connection among users that are tied in one or more

specific types of interdependency.
e Software Repository—Software repositories.
e Travel—Travel-related apps and services.

e Web Content—Mostly app-based services that provide content. It can be via login and/or paid portal.

Content Category Descriptions

e Academic Fraud—Sites that promote educational fraud, including but not limited to plagiarism and cheating.
e Adult:

e Adult Themes—Sites that are adult in nature and are not defined in other rating categories.

Note: Select this category only if you want to be very restrictive on your network.

e Sexuality—Sites that provide information, images or implications of bondage, sadism, masochism, fetish, beating, body
piercing or self-mutilation. This category is not intended for LGBT-related sites that do not fall under the

aforementioned criteria.

e Alcohol—Sites about alcohol use, commercial and otherwise.

e Arts—Galleries and exhibitions; artists and art; photography; literature and books; performing arts and theater; musicals;

ballet; museums; design; architecture. Does not include movies or television.
e Astrology—Astrology; horoscope; fortune-telling; numerology; psychic advice; tarot.
e Auctions:

e Auctions—Sites for buying and selling through an auction.

e Classifieds—Sites for buying and selling (or bartering) goods and services. Includes sites with real estate and housing

listings.
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e Automotive—Sites about automobiles, including manufacturers, news, reviews, and hobbyist information.

e Business Services—Sites for corporations and businesses of all sizes, especially company websites.

e Chat:

e Chat—Sites where you can chat in real-time with groups of people. Includes IRC and video chat sites.
e Instant Messaging—Sites that offer access or software to communicate in real-time with other individuals.

e Child Abuse Content (CAC)—Sites that contain child sexual abuse content. For more information, see the Internet

Watch Foundation.

e Computer Security—Offering security products and services for corporate and home users.

e Dating—Sites for meeting other people.
e Digital Postcards—Dating, online personals, matrimonial agencies.

¢ Dining and Drinking—Eating and drinking establishments; restaurants, bars, taverns, and pubs; restaurant guides and

reviews.

e DIY Projects—Guidance and information to create, improve, modify, decorate and repair something without the aid of

experts or professionals.
e Drugs—Sites about illegal or recreational drug use.

e Dynamic and Residential —IP addresses of broadband links that usually indicate users attempting to access their home

network, for example for a remote session to a home computer.
e Ecommerce/Shopping—Sites that are online stores for products and services.
e Educational Institutions—Sites for schools, covering all age levels and types.
e Entertainment:

e Anime/Manga/Webcomic—Sites that host online comics, cartoons, and graphic novels.

e Fashion—Clothing and fashion; hair salons; cosmetics; accessories; jewelry; perfume; pictures and text relating to body

modification; tattoos and piercing; modeling agencies. Dermatological products are classified as Health and Nutrition.
e File Storage—Sites that offer space for hosting, sharing and backup of digital files.

e File Transfer Services—File transfer services with the primary purpose of providing download services and hosted file

sharing.

e Financial Institutions—Sites for banks, brokerages, trusts, and other financial organizations.
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e Freeware and Shareware—Providing downloads of free and shareware software.
e Gambling—Sites that offer gambling or information about gambling.
e Games—Sites that offer gameplay and information about games (news, tips, cheat codes).

e German Youth Protection—Content deemed harmful to minors. This category helps prevent viewing of youth-
endangering content in Germany. Block pages for this category will include German text. This list is not controlled by
Umbrella and is created to be controlled by the BPjM (Federal Review Board for Media Harmful to Minors) to be compliant
with German Law. For more information, see General Information.

Note: We do not guarantee compliance with German law.

e Government—Sites operated by government agencies, including city, state, regional, county and federal levels. Also

includes .mil domains.
e Hacking—Discussing ways to bypass the security of websites, software, and computers.

e Hate/Discrimination—Sites that promote intolerance based on gender, age, race, nationality, religion, sexual orientation

or other group identities.

e Health and Fitness—Sites that offer information about health care and health services. Includes fitness related sites and

information about health and fitness.
e Humor—Sites that are intended to be funny or humorous.
e Hunting—Professional or sports hunting, gun clubs, and other hunting-related sites.
o lllegal Activities:

e lllegal Activities—Promoting crime, such as stealing, fraud, illegally accessing telephone networks; computer viruses;

terrorism, bombs, and anarchy; websites depicting murder and suicide as well as explaining ways to commit them.

e Terrorism—Sites that promote terrorism or are linked with terrorist organizations.

e lllegal Downloads—Providing the ability to download software or other materials, serial numbers, key generators, and

tools for bypassing software protection in violation of copyright agreements. Torrents are classified as Peer File Transfer.
e Infrastructure:
e URL Shortener—An online application or service that converts a regular URL into a condensed format.

e Infrastructure—Content delivery infrastructure and dynamically generated content; websites that cannot be classified

more specifically because they are secured or otherwise difficult to classify.
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Internet Telephony—Telephonic services using the internet.

IT-ADM—Sites that offer gambling or information about gambling and tobacco. For more information, see the Italian

Nacional Agency.

IT-AGCOM—Sites that are deemed to infringe on intellectual property. For more information, see the Italian National

Agency.

Jobs/Employment—Sites that offer job listings, resume services, interview coaching, and similar employment-related

services.

Lingerie/Bikini—Sites displaying or dedicated to lingerie/bikini that could be considered adult-only.
Lotteries—Sweepstakes, contests, and state-sponsored lotteries.

Military—Miilitary, such as the armed forces, military bases, military organizations, anti-terrorism.

Mobile Phones—Short Message Services (SMS); ringtones and mobile phone downloads. Cellular carrier websites are

included in the Business and Industry category.

Nature—Natural resources; ecology and conservation; forests; wilderness; plants; flowers; forest conservation; forest,
wilderness, and forestry practices; forest management (reforestation, forest protection, conservation, harvesting, forest
health, thinning, and prescribed burning); agricultural practices (agriculture, gardening, horticulture, landscaping, planting,
weed control, irrigation, pruning, and harvesting); pollution issues (air quality, hazardous waste, pollution prevention,
recycling, waste management, water quality, and the environmental cleanup industry); animals, pets, livestock, and

zoology; biology; botany.

News/Media—Sites that offer news and information, including newspapers, broadcasters, and other publishers.
Non-Profits—Sites for non-profit or charity organizations and services.

Nudity—Sites that provide images or representations of nudity.

Online Communities:

e Blogs—Personal Sites or group journals, diaries or publications.

e Forums/Message Boards—Sites with discussions, including bulletin boards, message boards, and forums.

Online Meetings—Online meetings, desktop sharing, remote access, and other tools that facilitate multi-location

collaboration.

Online Trading—Online brokerages; websites that enable the user to trade stocks online; information relating to the stock

market, stocks, bonds, mutual funds, brokers, stock analysis and commentary, stock screens, stock charts, IPOs, stock
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splits. Services for spread betting on stocks and shares are classified as Gambling. Other financial services are classified as

Finance.
Organizational Email—Websites used to access business email (often through Outlook Web Access).

P2P/File Sharing—Sites that facilitate the sharing of digital files between individuals, especially through peer-to-peer

software, including torrent sites.
Paranormal—UFOs, ghosts, cryptid, telekinesis, urban legends, and myths.

Parked Domains—Sites that are placeholders "parked" for future use. Current uses may include single-page advertising

sites.

Personal Sites—Websites about and from private individuals; personal homepage servers; websites with personal

contents; personal blogs with no particular theme.

Personal VPN—Virtual private network (VPN) sites or tools that are typically for personal use and may or may not be

approved for corporate usage.
Photo Search and Images:
e Visual Search Engines—Sites for searching for images based on keywords.

e Photo Sharing—Sites for sharing photographs, as individual images, galleries, and albums.

Politics—Sites about politics, politicians, political parties and organizations. Government sites are separate.
Pornography—Anything relating to pornography, including mild depiction, soft pornography or hard-core pornography.
Professional Networking—Social networking for career or professional development. See also Social Networking.

Proxy/Anonymizer—Sites providing proxy bypass information or services. Also, sites that allow the user to surf the net

anonymously, including sites that allow the user to send anonymous emails.

Real Estate—Information that would support the search for real estate; office and commercial space; real estate listings,

such as rentals, apartments, and homes; house building.

Religious—Sites about religion, religious teachings and groups, and spirituality.
Research/Reference—Sites such as encyclopedias, dictionaries as well as other research-related resources.
SaaS and B2B—Web portals for online business services; online meetings.

Safe for Kids—Directed at, and specifically for, young children.
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Science and Technology—Science and technology, such as aerospace, electronics, engineering, mathematics, and other
similar subjects; space exploration; meteorology; geography; environment; energy (fossil, nuclear, renewable);

communications (telephones, telecommunications).
Search Engines and Portals:
e Search Engines—Sites that offer result listings based on keywords.

e Portals—Sites that offer gateways to the Internet as a whole, often including bundled services on their site.

Sex Education—Factual websites dealing with sex; sexual health; contraception; pregnancy.

Social Networking—Sites that promote interaction and networking between people.

Social Science—Sciences and history related to society; archaeology; anthropology; cultural studies; history; linguistics;

geography; philosophy; psychology; women's studies.
Society and Culture—Family and relationships; ethnicity; social organizations; genealogy; seniors; child-care.

Software/Technology—Sites about computing, hardware, and technology, including news, information, code and vendor

information.
Software Updates—Websites that host updates for software packages.

Sports—Sites about sports of all kinds, from professional to amateur, from news to league information and schedules.

Includes martial arts and MMA related sites.

Streaming Audio:

e  Music—Sites about music, including news, band and fan information.

e Radio—Sites that offer online radio listening or promote radio stations.

e Podcasts—Sites that offer podcasts, digital media files distributed over the Internet, often using syndication feeds, for

playback on portable media players and personal computers. Both audio and video podcasts are included.

Streaming Video:

e Movies—Sites that promote movies or offer movie watching online.

e Video Sharing—Sites for sharing video content.
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e Tasteless—Sites that contain information on such subjects as mutilation, torture, horror, or the grotesque. Includes pro-

anorexia and pro-suicide related sites.

e Television—Sites that promote television shows or offer television watching online.

e Tobacco—Sites about tobacco use and related products, commercial and otherwise.

e Travel—Sites with travel information and services, including reservations for airlines, cars, hotels, vacations, and trips.
e Weapons—Sites about weapons, commercial and otherwise.

e Web Hosting—Website hosting; bandwidth services.

e Web Page Translation—Translation of web pages between languages.

e  Webmail—Sites that offer the ability to send or receive email.
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Troubleshooting

What Policy is being applied?
Windows or Mac

The first step is to collect the debug output from the client machine that you wish to determine the
applied policy for. Debug output can be gathered by running the following commands from a command
prompt on Windows, or a Terminal window on OS X:

nslookup -g=txt debug.opendns.com

The output should look similar to this:

c:\>nslookup —g=txt debug.opendns.
Server: resolverld.opendns.com
Address: 208.67.222.222

Non—authoritative answer:
debug.opendns .com text

"server 3.pao"

debug.opendns.com text =

"flags 280 B 47E4 DOPAPBAOAOABBOR41 "'
debug.opendns.com text =

“originid 23443359"
debug.opendns.com text

orgid 162145"
debug . o pewdnsTeow text

"actype B
debug.opendns.com text

"hundle 147229"
debug . opesdas.con text

For our purpose, the important information here is the OrgID and the Bundle. The OrgID is the identifier of
your organization's dashboard, and the Bundle is the identifier of the applied policy within that
organization.

Next, log in to your Umbrella dashboard and open a new tab or window in the browser. Then, plug the
two variables pulled from the debug output into the URL below:

https://dashboard.umbrella.com/o/<OrgID> /#/configuration/policy/<Bundle-ID>

This will take you directly to the policy that was applied to the computer (or user) the debug output was
run on, at the time it was run.
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Chromebook
Access the diagnostic page by browsing to http://localhost:8029/debug in a new tab.

The output should look similar to this:

O 0 % Extensions X NewTab X |

O 1 locahost8029/debug

[ localhost:8029/debug - Cisco Umbrella Chromebook client debug information
Q localhost:8029/debug - Google Search

ece Cisco Umbrella Chromebook « X

& C' | % Cisco Umbrella Chromebook client (Ext) | chrome-extension://aekhbkcdcfgohgcafdpkijjlokhdlhnok/debug.html?os=cros&osVer... ¢

Cisco Umbrella Chromebook client

Debug Info. collected at: Mon Sep 03 2018 15:44:15 GMT+0530 (India Standard Time)

0s cros
0S Version 68.0.3440.106

Organization ID 2442562

User Email E R e &t W}
Local IP 10.103.10.124
Policy Url https://dashboard.umbrella.com/0/2442562/#/configuration/policy/382835

For our purpose, the important information here is the "OrganizationID" and the "Policy Url". The
"OrganizationlID" is the identifier of your organization's dashboard, and the "Policy Url" is the identifier of
the applied policy within that organization.

Next, log in to your Umbrella dashboard and open a new tab or window in the browser. Then, navigate to
the "Policy Url" which will take you directly to the policy that was applied to the computer (or user) the
debug output was run on, at the time it was run.

123|Page


http://localhost:8029/debug

Gathering or clearing AD Connector Logs

A functional AD Connector is green. Grey, yellow, and red statuses usually reflect a problem.

9 Sites & Active Directory
=

ADO1 AD Connector | installed: 4 days ago 1.1.11

ADO1

The Connector was once connected, but is not currently connected to any of the DCs available. For more
information, and steps to resolve, please visit: https://support.opendns.com/entries/57607634#connector-
once-not-now

The Connector was once connected but is not currently connected to any of the VAs available. For more
information, and steps to resolve, please visit: https://support.opendns.com/entries
/57607634#connector-no-va

For each AD Connector which cannot connect to a Domain Controller, or has an error/warning in the
Dashboard, you should provide the AD Connector Log so Umbrella support can examine the findings.

Logs

To obtain the logs manually, follow the steps below:

e Attach the file C:\Program Files (x86)\OpenDNS\OpenDNS Connector\v1.xx\OpenDNSAuditClient.log

e Attach the latest couple .zip log files from C:\Program Files (x86)\OpenDNS\OpenDNS
Connector\v1.x.x\ to the support ticket (do not send more than 3 .zip files)
o If the files are over 20MB, split them into two responses or contact us for upload details.

If working with a fresh configuration which has never worked, or if asked to send new logs:

o Stop the OpenDNS AD Connector service,

o Delete the file "C:\Program Files (x86)\OpenDNS\OpenDNS Connector\v1.x.x\OpenDNSAuditClient.log".

o Start the service up again.
e Wait 5 minutes and reply with this file.

This allows the file to be fresh and only with the most recent startup attempt.
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CIDR Table

CIDR SUBNET
0 0.0.0.0
1 128.0.0.0
2 192.0.0.0
3 224.0.0.0
4 240.0.0.0
5 248.0.0.0
6 252.0.0.0
7 254.0.0.0
8 255.0.0.0
9 255.128.0.0
10 255.192.0.0
11 255.224.0.0
12 255.240.0.0
13 255.248.0.0
14 255.252.0.0
15 255.254.0.0
16 255.255.0.0
17 255.255.128.0
18 255.255.192.0
19 255.255.224.0
20 255.255.240.0
21 255.255.248.0
22 255.255.252.0
23 255.255.254.0
24 255.255.255.0
25 255.255.255.128
26 255.255.255.192
27 255.255.255.224
28 255.255.255.240
29 255.255.255.248
30 255.255.255.252
31 255.255.255.254
32 255.255.255.255
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